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Flux de lucru: Crearea de colecții  

1. Selectarea Rădăcinii: 

o În Navigation Tree, executați Clic dreapta pe folderul proiectului nou creat (Ex: 
Project U797). 

o Alegeți New. 

 

2. Configurarea Colecțiilor: 

o În dialogul New, bifați Collection. 

o Introduceți 5 în câmpul Amount (Cantitate). 

o Faceți clic pe OK. 
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3. Redenumirea: 

o Redenumiți colecțiile noi pentru a le da o semnificație structurală (Ex: Process, 
Libraries). 

 

Flux de lucru: Importul datelor în proiect 

1. Selectarea Destinației: 

o În Navigation Tree, selectați colecția Libraries (creată anterior). 

 

2. Activarea Importului: 

o Alegeți File → Import/Export → Import eBOP from File (Fișier → Import/Export 
→ Import eBOP din Fișier). 
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3. Localizarea Fișierului Sursă: 

o Navigați la directorul de fișiere de import/export (Ex: Import Export files folder). 

o Selectați fișierul de bibliotecă (Ex: RoboticsExampleResourceLibrary082211.xml). 
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4. Finalizarea Importului: 

o Faceți clic pe Import. 

o Rezultat: Va apărea un mesaj de succes, confirmând că datele de resursă (biblioteca) 
au fost adăugate în colecția Libraries a proiectului. 

 

Flux de lucru: Exportul proiectului într-un fișier 

1. Selectarea Proiectului: 

o În Navigation Tree, selectați folderul rădăcină al proiectului (Ex: Project U797). 

 

2. Activarea Exportului: 

o Alegeți File → Project management → Export selected eBOP to File (Fișier → 
Management Proiect → Exportă eBOP Selectat în Fișier). 
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3. Definirea Ieșirii: 

o Navigați la directorul de salvare dorit (Ex: Import Export files\sysroot folder). 

o Introduceți un nume de fișier (Ex: MyProject USERID_UNDEFINED.xml). 

 

4. Finalizarea Exportului: 

o Faceți clic pe OK. 

o Rezultat: Datele proiectului sunt salvate ca un fișier .xml de tip eBOP, putând fi 
utilizate pentru arhivare sau transfer. 
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Comenzile de management al proiectului sunt vitale pentru menținerea integrității datelor în mediul 
eMS. Posibilitatea de a crea, importa și exporta date eBOP le permite inginerilor să structureze 
proiectele într-un mod organizat și să facă schimb de date de simulare cu alte sisteme sau utilizatori. 

 

1.2. UTILIZAREA PROCESS SIMULATE DISCONNECTED 
 

Process Simulate Disconnected (mod deconectat) este un mod de lucru autonom care permite 
utilizatorului să ruleze simulări și să editeze date locale (Study Files, .PSZ) fără conexiune la serverul 
eMS (Teamcenter). Acest mod este util pentru lucru în deplasare sau atunci când conexiunea la rețea 
nu este disponibilă. 

 

1.2.1. Pornirea și Ieșirea din Process Simulate Disconnected 

Obiectiv: Salvarea unui fișier de studiu (.PSZ) din mediul conectat, configurarea directorului 
rădăcină local și încărcarea studiului în modul deconectat. 

Flux de lucru: Salvarea unui fișier .PSZ din modul conectat 

1. Încărcarea Studiului: 

o Deschideți Process Simulate (modul conectat) și încărcați un studiu existent care 
conține operații simulative (Ex: un studiu din Project_209S). 
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o Accesarea Operation Tree: Selectați fereastra de vizualizare Operation Tree. 

o Inițierea unei noi operațiuni: Mergeți la meniul de sus și alegeți: Operations apoi 
New Operation și apoi New Compound Operation. 
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o Configurarea operațiunii: În fereastra de dialog care apare (New Compound 
Operation): 

1. La câmpul Name (Nume), tastați: MyOperations. 

2. La câmpul Scope (Domeniu), selectați din lista derulantă: Operation Root. 

o Finalizare: Faceți clic pe butonul OK. 

 

o Selectarea rădăcinii: În fereastra Operation Tree, selectați operațiunea compusă 
creată anterior, numită MyOperations. 

o Selecția obiectului: Mențineți apăsată tasta [Ctrl]. 

o Identificarea vizuală: Din fereastra grafică (Graphic Viewer), selectați obiectul 
numit room_door_demo. 

o Eliberarea tastei: Puteți elibera tasta [Ctrl]. 

o Crearea operațiunii de dispozitiv: Accesați din nou meniul: Operations New 
Operation apoi New Device Operation. 

o Notă: Numele și dispozitivul ar trebui să fie deja completate automat în fereastra de 
dialog. 

o Setarea poziției de pornire: În fereastra New Device Operation, selectați opțiunea 
CLOSED din lista derulantă From pose (Din poziția). 
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o Setarea poziției finale: Selectați opțiunea OPEN din lista derulantă To pose (Către 
poziția). 

o Finalizare: Faceți clic pe butonul OK. 

 

2. Salvarea Fișierului .PSZ: 

o Alegeți File → Save As (Fișier → Salvează Ca). 

o Navigați la o locație temporară (Ex: C:\temp\disconnected). 

o Pentru Save as type (Salvează ca tip), selectați Study Files (*.psz) and Library 
Components (Fișiere Studiu și Componente Bibliotecă). 

o Introduceți un nume de fișier (Ex: Verify.psz). 

o Faceți clic pe Save (Salvează). 
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3. Salvarea Componentelor Bibliotecii: 

o Confirmați salvarea fișierului Verify.psz. 

o Sistemul va salva apoi automat un fișier Verify-LibraryComponents.zip care conține 
toate prototipurile de resurse necesare. 

o Faceți clic pe OK pentru a confirma salvarea arhivei. 

 

4. Extragerea Arhivei: 

o Ieșiți din Process Simulate conectat (File → Exit), selectând No la actualizarea 
eMServer. 

o Navigați în Windows Explorer la locația de salvare (Ex: C:\temp\disconnected). 
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o Extrageți conținutul arhivei Verify-LibraryComponents.zip într-un folder nou, numit 
(Ex: disconnected_sysroot). 

o Notă: Acest folder va servi ca director rădăcină local pentru modul deconectat. 

 

Flux de lucru: Pornirea Process Simulate Disconnected 

1. Lansarea Aplicației: 

o Lansați Process Simulate Disconnected (din pictograma dedicată de pe desktop sau 
din meniul Start). 

 

2. Configurarea System Root Local: 

o Alegeți Tools → Options. 

o În dialogul Options, faceți clic pe fila Disconnected (Deconectat). 

o Lângă Client System Root, faceți clic pe butonul Browse (...). 

 

o Selectați folderul creat anterior (Ex: C:\temp\disconnected\disconnected_sysroot). 
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o Faceți clic pe OK de două ori. 

3. Încărcarea Studiului .PSZ: 

o Alegeți File → Open in Standard Mode (Fișier → Deschide în Mod Standard). 

o Navigați la C:\temp\disconnected și selectați fișierul Verify.psz. 

o Faceți clic pe Open (Deschide). 

o Rezultat: Studiul se încarcă în modul deconectat, utilizând componentele bibliotecii 
din directorul disconnected_sysroot. 

 

Flux de lucru: Efectuarea modificărilor și salvarea 

1. Efectuarea Modificărilor Locale: 

o În Object Tree, redenumiți un obiect din folderul Resources. 

o Mutați un obiect (Ex: cu Placement Manipulator) cu o anumită distanță (Ex: 500 
mm). 

2. Salvarea Modificărilor: 

o Alegeți File → Save (Fișier → Salvează). Modificările sunt salvate în fișierul 
Verify.psz local. 

3. Ieșirea: 

o Alegeți File → Exit (Fișier → Ieșire). 
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Lucrul în modul Disconnected oferă flexibilitate și autonomie. Salvarea studiului ca fișier .PSZ, 
împreună cu componentele bibliotecii, permite efectuarea completă a analizelor și modificărilor 
offline, care pot fi apoi reintegrate în baza de date eMS după revenirea în modul conectat. 

 

1.2.2. Actualizarea Process Simulate Disconnected din Baza de Date eMS 

Obiectiv: Actualizarea unui fișier de studiu local (.PSZ) cu cele mai recente modificări din baza de 
date eMS, utilizând comanda Update PSZ File din modul conectat. 

Atunci când se lucrează în modul deconectat, fișierul .PSZ poate deveni învechit față de conținutul 
din eMS. Comanda Update PSZ File permite deschiderea fișierului local în mediul conectat, 
aplicarea actualizărilor din eMS și salvarea unei versiuni .PSZ actualizate, gata pentru utilizare 
offline. 

Flux de lucru: Pregătirea și actualizarea fișierului PSZ 

1. Lansarea și autentificarea (mod conectat): 

o Porniți Process Simulate (mod conectat) și autentificați-vă în eMS. 

o Deschideți proiectul corespunzător. 

 

2. Încărcarea Fișierului .PSZ Vechi: 

o Alegeți File → Open in Standard Mode (Fișier → Deschide în Mod Standard). 

o Navigați și selectați fișierul .PSZ vechi (Ex: Verify.psz) salvat anterior în directorul 
C:\temp\disconnected. 

o Faceți clic pe Open. 
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3. Executarea Actualizării eMServer (Simulare): 

o Alegeți File → eMServer Selective Update (Această acțiune simulează sincronizarea 
datelor din eMS cu fișierul .PSZ care a fost deschis). 

o Bifați casetele Resources și Operations (sau cele relevante). 
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o Faceți clic pe OK și OK din nou. 

o Observație: Această acțiune aduce datele din eMS în sesiunea curentă. 

4. Actualizarea Fișierului .PSZ (Update PSZ File): 

o (Notă: Pentru a accesa această funcție, poate fi necesară adăugarea pictogramei 
Update PSZ File la bara de instrumente din Tools → Customize). 

o Faceți o mică schimbare în studiu (Ex: redenumiți un alt obiect în folderul Resources) 
pentru a declanșa o actualizare. 

o Faceți clic pe Update PSZ File de pe bara de instrumente. 

o Dacă apare avertismentul, faceți clic pe Yes pentru a continua. 

 

5. Configurarea Opțiunilor de Salvare: 

o În dialogul Update PSZ File: 

▪ În lista Parts and resources to update, selectați explicit obiectele care s-au 
schimbat. 

▪ Source PSZ file (Fișier PSZ Sursă): Selectați fișierul .PSZ inițial (Ex: 
Verify.psz). 

▪ Target PSZ file (Fișier PSZ Țintă): Introduceți un nume nou de fișier pentru 
versiunea actualizată (Ex: Verify_Updated.psz). 

▪ Bifați Save library components (Salvează componentele bibliotecii). 
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▪ Navigați la directorul local (C:\temp\disconnected\disconnected_sysroot) 
pentru salvarea noilor componente de bibliotecă (care vor suprascrie datele 
vechi). 

o Faceți clic pe OK. 

 

o Confirmați că doriți să vizualizați fișierul jurnal (Log File). 

6. Verificarea Finală: 

o Ieșiți din Process Simulate conectat. 

o Porniți Process Simulate Disconnected. 

 

 

o Încărcați noul fișier .PSZ (Ex: Verify_Updated.psz) pentru a vedea datele actualizate. 

Update PSZ File este instrumentul oficial pentru sincronizarea datelor locale cu cele din baza de 
date. El asigură că inginerul care lucrează offline utilizează cea mai recentă geometrie și cele mai noi 
prototipuri de resurse, menținând consistența datelor. 
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1.2.3. Actualizarea Bazei de Date eMS din Process Simulate Disconnected 

Obiectiv: Sincronizarea modificărilor efectuate în modul deconectat (în fișierul .PSZ local) înapoi în 
baza de date eMS (Teamcenter). 

După ce se fac modificări în modul deconectat (Ex: redenumiri de obiecte, mutări de poziție), acestea 
sunt salvate în fișierul .PSZ. Pentru ca aceste modificări să fie vizibile și permanente pentru ceilalți 
utilizatori, fișierul .PSZ trebuie încărcat înapoi în modul conectat, iar datele trebuie exportate în eMS. 

Flux de lucru: Exportul schimbărilor către eMS 

1. Pornirea și autentificarea (mod conectat): 

o Porniți Process Simulate (mod conectat) și autentificați-vă. 

o Deschideți proiectul de referință. 

2. Încărcarea Fișierului .PSZ Modificat: 

o Alegeți File → Open in Standard Mode. 

o Navigați și selectați fișierul .PSZ care conține modificările făcute offline (Ex: 
Verify.psz cu obiectul redenumit). 

o Faceți clic pe Open. 

3. Actualizarea Bazei de Date: 

o Alegeți File → eMServer Selective Update (Actualizare Selectivă eMServer). 

o Atenție: Asigurați-vă că fișierul .PSZ este deschis înainte de a efectua eMServer 
Selective Update. 

o Bifați casetele Resources și Operations (sau cele relevante, care au fost modificate). 

 

o Faceți clic pe OK și OK din nou pentru a confirma exportul. 
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o Rezultat: Modificările locale din fișierul .PSZ (Ex: noul nume al obiectului, noua 
poziție) sunt acum scrise permanent în baza de date eMS. 

Flux de lucru: Verificarea finală 

1. Verificarea: 

o Închideți studiul, reîncărcați-l din Navigation Tree și verificați că modificările (Ex: 
noul nume/poziție) persistă și sunt preluate direct din eMS. 

Ciclul de lucru Connected → Disconnected → Update eMS este un proces standard de inginerie. 
Folosirea eMServer Selective Update după încărcarea unui fișier .PSZ modificat permite integrarea 
controlată și sigură a muncii offline în mediul colaborativ. 
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2. BAZELE MODELĂRII 

 

 

Modelarea directă în Process Simulate este esențială pentru crearea sau modificarea rapidă a 
geometriei staționare (mese de lucru, structuri, baze de fixare). Acest capitol introduce fluxul de lucru 
pentru inițierea unei sesiuni de modelare și utilizarea primitivelor geometrice simple (Solids 
Creating with Primitives – creare de solide cu primitive) și a operațiilor booleene, pentru a construi 
geometrii complexe. 

 

2.1. PREZENTARE GENERALĂ A BAZELOR MODELĂRII 
 

2.1.1. Schimbarea proiectelor și setarea folderului de lucru (Working Folder) 

Obiectiv: Autentificarea în proiectul de referință (Project_209S) și setarea directorului de lucru 
Working Folder (folder de lucru) pentru operațiile de modelare ulterioare. 

Flux de lucru: accesarea proiectului și setarea folderului 

1. Lansarea și Logarea: 

o Lansați Process Simulate și autentificați-vă folosind eMS database user ID (ID 
utilizator în baza de date eMS; ex.: user1). 

o Faceți clic pe OK. 

2. Deschiderea Proiectului: 

o În dialogul Open Project (Deschidere proiect), selectați proiectul Project_209S. 

o Faceți clic pe OK. 

3. Check Out pentru folderul de lucru: 

o Navigați la colecția Working Folders în Navigation Tree (arbore de navigare). 

o Faceți clic dreapta pe folderul alocat utilizatorului (ex.: user1) și alegeți Check Out 
(extrage pentru editare). 
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o Faceți clic pe OK. 

4. Setarea folderului ca activ: 

o Alegeți File → Project Management → Set as Working Folder. 

 

2.1.2. Deschiderea studiului de lucru 

Obiectiv: Încărcarea studiului de referință care va servi ca mediu de lucru pentru modelare. 

Flux de lucru: încărcarea studiului 

1. Navigarea la Studii: 

o În Navigation Tree (arbore de navigare), extindeți colecția Studies. 

o Faceți clic dreapta pe folderul de studiu alocat (ex.: Line1 StudyFolder) și alegeți 
Check Out (extrage pentru editare). 

o Bifați with Hierarchy (cu ierarhie) în dialogul Check Out și faceți clic pe OK. 

2. Încărcarea Studiului: 

o Navigați la folderul processing. 

o Faceți clic dreapta pe studiul dorit (ex.: station02) și alegeți Load in Standard Mode 
(încărcare în mod standard). 

o Observație: Dacă nodurile studiului sunt deja checked out de alt utilizator, acestea nu 
vor putea fi actualizate în baza de date după finalizarea lucrului. 

3. Vizualizarea: 

o Așteptați încărcarea studiului. 

o Alegeți Zoom To Fit (încadrare) din bara de instrumente pentru a vizualiza datele 3D 
în Graphic Viewer (vizualizator grafic). 



Proiectarea și Simularea Sistemelor de Producție în Process Simulate 

33 
 

Prin finalizarea acestei secțiuni, mediul de lucru (proiect, folder de lucru și studiu) este pregătit pentru 
inițierea operațiilor de modelare geometrică. 

 

2.2. CREAREA DE SOLIDE CU PRIMITIVE 
 

Modelarea cu primitive geometrice implică utilizarea formelor de bază (Box – cutie, Cylinder – 
cilindru, Sphere – sferă) pentru a construi geometrii mai complexe. Procesul necesită intrarea în 
Modeling Scope (scop de modelare), crearea unui obiect de tip resursă (Resource – resursă) și 
utilizarea operațiilor booleene (ex.: Subtract – scădere) pentru a finaliza modelul. 

 

2.2.1. Modelarea unei mese de lucru 

Obiectiv: Crearea unui model de masă (ex.: o masă cu patru picioare) utilizând primitiva Box și 
operația Subtract, apoi salvarea modelului ca fișier .cojt. 

Flux de lucru: pregătirea studiului și a resursei 

1. Crearea unui Studiu Temporar: 

o Dacă nu lucrați în studiul anterior, închideți-l (File → Close Project). 

o Creați un folder nou de studiu sub folderul utilizatorului (ex.: StudyFolder). 

 

 

o Creați un studiu nou de tip RobcadStudy în acest folder și denumiți-l temp. 
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2. Încărcarea și pregătirea: 

o Încărcați studiul temp (Load in Standard Mode). 

o Alegeți Modeling → Create Part/Resource → New Resource (Modelare → Creare 
piesă/resursă → Resursă nouă). 

o Selectați tipul Work_Table și faceți clic pe OK. 

o Redenumiți noul obiect (ex.: mytable_user1). 

 

3. Setarea unităților: 

o Alegeți Tools → Options → Units. 

o Setați unitatea Linear (liniar) la mm. Faceți clic pe OK. 

 

o Notă: Toate datele sunt stocate în mm, însă această setare influențează doar unitățile 
afișate. 
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o Setați Pick Level (nivel de selecție) la Entity (entitate). 

Flux de lucru: crearea geometriei de bază (cutie și picioare) 

1. Intrarea în Modeling Scope: 

o Selectați obiectul mytable_user1 în Object Tree (arbore de obiecte). 

o Alegeți Modeling → Set Modeling Scope (Modelare → Setare scop de modelare). 
Confirmați cu Yes. 

o Rezultat: Obiectul este pregătit pentru editare. 

2. Crearea corpului principal (masă): 

o Alegeți Modeling → Create 3D → Box Creation → Create a Box (Modelare → 
Creare 3D → Cutie). 

o Setați dimensiunile (ex.: Length: 1000, Width: 1000, Height: 1000). 

o În secțiunea Location, asigurați-vă că Locate at este setat la Working Frame (cadru 
de lucru). 

o Faceți clic pe OK (aceasta va fi box1). 

 

3. Crearea golurilor (picioare – volume de scăzut): 

o Creați o a doua cutie (pentru a reprezenta spațiul gol al picioarelor pe axa X): 

▪ Name: box2 

▪ Dimensions: (ex.: Length: 2000, Width: 800, Height: 800) 
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▪ Locate at: Working Frame. Faceți clic pe OK. 

 

o Creați o a treia cutie (pentru a reprezenta spațiul gol al picioarelor pe axa Y): 

▪ Name: box3 

▪ Dimensions: (ex.: Length: 800, Width: 2000, Height: 800) 

▪ Locate at: Working Frame. Faceți clic pe OK. 

 

Flux de lucru: aplicarea operației booleene (Subtract) 

1. Pregătirea Selecției: 

o Asigurați-vă că Pick Level este setat la Entity. 

o Țineți apăsată tasta [Ctrl] și selectați cele două cutii de gol (ex.: box2 și box3) în 
Object Tree sau în Graphic Viewer. 
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2. Activarea Subtract: 

o Alegeți Modeling → Edit → Subtract (Modelare → Editare → Scădere). 

 

3. Configurarea Operației: 

o Subtract entities: Cutiile box2 și box3 ar trebui să fie deja populate. 

o From entity: Faceți clic în această casetă și selectați cutia mare (box1) din Graphic 
Viewer. 

o Bifați Delete original entities (Șterge entitățile originale). 

o Introduceți un nume nou pentru solidul rezultat (Ex: bool1). 

o Faceți clic pe OK. 

4. Rezultat: Geometria rezultată (bool1) este masa cu patru picioare, creată prin scăderea celor 
două volume din corpul principal. 
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Flux de lucru: salvarea și ieșirea din modelare 

1. Salvarea Componentei: 

o Selectați obiectul mytable_user1 în Object Tree. 

 

o Alegeți Modeling → End Modeling (finalizare modelare). 

o În dialogul Save Component As (salvare componentă ca), navigați la directorul de 
biblioteci (ex.: \\Libraries\\modeling_kinematics\\toolprototype folder). 

o Introduceți un nume de fișier (Ex: mytable.cojt). 

o Faceți clic pe Save. 

 

o Rezultat: Modelul este salvat ca un fișier .cojt și redevine o resursă în studiul curent. 
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Modelarea directă prin primitive și operații booleene este o metodă rapidă și eficientă de generare a 
geometriei statice pentru simulare. Salvarea modelului ca fișier .cojt îl transformă într-o resursă 
reutilizabilă în cadrul proiectelor. 

 

2.3. UTILIZAREA WIREFRAME PENTRU CREAREA DE SOLIDE 
 

Modelarea prin tehnici Wireframe (cadru de sârmă) permite crearea de solide complexe, în special 
corpuri de revoluție, pornind de la entități 2D (linii, curbe, polilinii). Această metodă oferă un control 
parametric ridicat asupra formei finale și este adesea utilizată pentru a modela piese rotunde sau axiale 
(roți, vase, mânere). 

 

2.3.1. Rotirea entităților 2D pentru a crea un solid 

Obiectiv: Utilizarea comenzilor de desenare 2D, tăiere (Split – separare) și revoluție (Revolute – 
revoluție) pentru a crea un solid complex. 

Flux de lucru: pregătirea studiului și a resursei 

1. Reîncărcarea Studiului: 

o În Navigation Tree, navigați la folderul Working Folders al utilizatorului. 

o Faceți clic dreapta pe studiul temp și alegeți Load in Standard Mode. La salvarea 
modificărilor din studiul anterior, răspundeți No. 

2. Crearea Resursei Noi: 

o Alegeți Modeling → Create Part/Resource → New Resource. 

o Selectați Tool Prototype și faceți OK. 

o Redenumiți noul obiect (Ex: fun1_user1). 

3. Setarea Modeling Scope: 

o Selectați fun1_user1. 
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o Alegeți Modeling → Set Modeling Scope. Confirmați cu Yes. 

Flux de lucru: crearea profilului 2D (Wireframe) 

1. Crearea axelor de referință (Polylines – polilinii): 

o Axa Orizontală (Axa de Revoluție): 

▪ Alegeți Modeling → Create 2D → Create Polyline. 

▪ Punctul 1: Coordonate (X: 0, Y: 0, Z: 0). 

▪ Punctul 2: Coordonate (X: 1000, Y: 0, Z: 0). 

▪ Faceți clic pe OK (aceasta este Polyline2, axa de revoluție, de-a lungul axei X 
a Working Frame). 

 

o Linia de Bază (Tăiere): 

▪ Alegeți Modeling → Create 2D → Create Polyline. 

▪ Punctul 1: Coordonate (X: 0, Y: 200, Z: 0). 

▪ Punctul 2: Coordonate (X: 1000, Y: 200, Z: 0). 

▪ Faceți OK. (Aceasta este Polyline1, linia care va ajuta la definirea profilului). 

2. Crearea Curbei Ondulate (Wavy Curve): 

o Setați Pick Intent (intenția de selecție) la Where Picked (după punctul selectat). 

o Alegeți Modeling → Create 2D → Create Curve. 

o Selectați succesiv mai multe puncte în planul XY al Working Frame pentru a crea o 
curbă ondulată. 

o Cerințe: Curba trebuie să intersecteze Polyline1 doar la cele două capete și nu trebuie 
să traverseze axa X a Working Frame (axa de revoluție). 

o Faceți OK. 
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Flux de lucru: editarea și tăierea curbei (Split Curve on Intersection) 

1. Tăierea Curbei: 

o Alegeți Modeling → Create 2D → Split Curve on Intersection (tăierea curbei la 
intersecție). 

o Curve: Selectați curba ondulată (ex.: Curve 1). 

o Intersecting entity: Selectați Polyline1 (linia dreaptă la Y = 200). 

o Faceți OK. 

o Rezultat: Curba ondulată este împărțită în trei segmente (ex.: Curve1_1, Curve1_2, 
Curve1_3). 

2. Ștergerea Entităților Nedorite: 

o Folosind Object Tree sau funcția Blank/Display (ascundere/afișare), identificați și 
ștergeți segmentele scurte de curbă care se extind dincolo de Polyline1 (cel mai 
probabil Curve1_1 și Curve1_3). Ștergeți și Polyline1. 

o Rezultat: Rămâne un singur segment de curbă (Ex: Curve1_2) și linia de-a lungul 
axei X (Polyline2). 

Flux de lucru: crearea solidului de revoluție 

1. Selecția Profilului: 

o Selectați curba ondulată finală (segmentul care a rămas). 

2. Activarea Revoluției: 

o Alegeți Modeling → Edit → Revolute (revolve). 

3. Definirea Axelor și Unghiului: 

o Start: Selectați un capăt al liniei de-a lungul axei X (Polyline2). 

o End: Selectați celălalt capăt al liniei de-a lungul axei X (Polyline2). 

o Rotation From: Introduceți 0. 

o Rotation To: Introduceți 270 (pentru a crea un solid care nu este complet închis; ex.: 
cu un segment lipsă). 

o Bifați Preview pentru a vedea rezultatul. 

o Faceți OK. 
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Flux de lucru: Salvarea și Ieșirea din Modelare 

1. Salvarea Componentei: 

o Selectați obiectul fun1_user1 în Object Tree. 

o Alegeți Modeling → End Modeling. 

o Salvați-l în directorul de biblioteci (Ex: 
\Libraries\modeling_kinematics\toolprototypes folder). 

o Rezultat: Solidul de revoluție este salvat ca un fișier .cojt. 

Modelarea prin revoluție este o tehnică avansată care transformă un profil 2D într-o formă 3D 
complexă, fiind deosebit de utilă în crearea de unelte, piese simetrice și structuri circulare necesare 
pentru simulările robotice. 

 

2.3.2. Extrudarea entităților 2D pentru a crea un solid  

Obiectiv: Crearea unui solid complex (ex.: o piesă cu colțuri rotunjite) prin extrudarea unui profil 2D 
închis, utilizând comenzi de desenare, măsurare și rotunjire (Fillet – racordare). 

Extrudarea este o tehnică de modelare care transformă un profil 2D (o formă plană închisă) într-un 
volum 3D, deplasând profilul de-a lungul unei direcții. Această metodă este fundamentală pentru 
crearea de corpuri prismatice sau piese cu secțiune constantă. 

Flux de lucru: pregătirea și crearea profilului 2D (triunghi) 

1. Crearea Resursei Noi: 

o Alegeți Modeling → Create Part/Resource → New Resource. 

o Selectați Tool Prototype și faceți OK. 

o Redenumiți noul obiect (Ex: fun2_user1). 

o Intrarea în Modeling Scope: Selectați fun2_user1 și alegeți Modeling → Set 
Modeling Scope. 

2. Crearea Liniilor de Bază (Wireframe): 

o Alegeți Modeling → Create 2D → Create Polyline. 
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o Atenție: Creați trei segmente de linie care formează un triunghi, dar lăsați un mic 
spațiu deschis la colțuri (nu le uniți complet). 

o Repetați procesul de două ori pentru a obține ceilalți doi segmenți de linie. 

 

Flux de lucru: măsurarea și rotunjirea colțurilor (Fillet) 

1. Măsurarea Lungimii (PTP Distance): 

o Setați Pick Intent la Snap (aliniere la puncte). 

 

o Din bara de instrumente Measurements (măsurători), alegeți PTP Distance (distanță 
punct-la-punct). 

o Selectați două colțuri ale triunghiului pentru a măsura lungimea celei mai scurte laturi. 

o Închideți dialogul Point to Point Distance (distanță punct-la-punct) și rețineți 
valoarea măsurată. 

2. Rotunjirea Colțului 1 și 2 (Fillet): 

o Alegeți Modeling → Create 2D → Fillet (Rotunjire). 

o Faceți clic pe cele două laturi adiacente ale primului colț. 

o În dialogul Fillet, introduceți o valoare pentru Radius (Rază) (Ex: o zecime din 
lungimea măsurată). 

o Bifați Delete original entities (Șterge entitățile originale). 

o Faceți clic pe Preview, apoi OK. 

 

o Repetați procesul pentru cel de-al doilea colț. 
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Flux de lucru: finalizarea și extrudarea profilului 

1. Crearea unei Polilinii Temporare: 

o Deoarece comanda Fillet necesită două curbe separate, creați o polilinie temporară 
care să traverseze spațiul deschis rămas. 

o Alegeți Modeling → Create 2D → Create Polyline și trageți o linie scurtă care 
traversează marginile deschise ale colțului rămas. 

 

2. Tăierea și Rotunjirea Colțului 3: 

o Alegeți Modeling → Create 2D → Split Curve on Intersection (Taie Curba la 
Intersecție), selectând profilul triunghiular și polilinia temporară. Aceasta separă 
laturile rămase. 

o Ștergeți polilinia temporară. 

o Aplicați Fillet pe cele două laturi separate ale colțului rămas, folosind aceeași rază și 
bifând Delete original entities. 

 

3. Unirea Entităților (Merge Curves): 

o Desenați o casetă de selecție (boxă) în jurul întregului profil triunghiular închis. 

o Alegeți Modeling → Create 2D → Merge Curves (unificarea curbelor). 

o Bifați Delete original entities. Faceți OK. 

o Rezultat: Toate segmentele se unesc într-o singură entitate Curve (Curvă), care 
reprezintă profilul închis. 
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4. Extrudarea în Solid: 

o Selectați entitatea Curve (profilul închis). 

o Alegeți Modeling → Edit → Extrude (extrudare). 

o În dialogul Extrude, introduceți o valoare pentru Positive (Ex: 200) pentru a defini 
înălțimea (adâncimea) extrudării. 

 

o Trageți de manipulatorii afișați în Graphic Viewer pentru a ajusta dimensiunea. 

o Faceți OK. 

o Rezultat: Profilul 2D este transformat într-un solid 3D. 

 

Flux de lucru: Salvarea și Ieșirea din Modelare 

1. Salvarea Componentei: 

o Selectați obiectul fun2_user1 în Object Tree. 

o Alegeți Modeling → End Modeling. 

o Salvați-l în directorul de biblioteci (Ex: 
\Libraries\modeling_kinematics\toolprototypes folder). 

o Rezultat: Modelul solid este salvat ca fișier .cojt. 
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Extrudarea este un instrument de bază, dar robust, în procesul de modelare. Combinată cu tehnici de 
rotunjire și unire a curbelor, permite crearea rapidă a componentelor funcționale, necesare pentru 
verificări de interferență și asamblare în mediul de simulare. 

 

2.4. MODELAREA PISTOALELOR DE SUDURĂ 
 

2.4.1. Extrudarea entităților 2D de-a lungul unui traseu pentru a crea un solid  

Obiectiv: Crearea unui solid complex (ex.: un gât de pistol de sudură curbat) prin Sweeping 
(măturare) a unui profil circular de-a lungul unei curbe de ghidare (Arc – arc). 

Sweeping este o tehnică de modelare avansată care generează un solid 3D prin deplasarea unei 
secțiuni 2D (profil) de-a lungul unei căi 3D (curbă de ghidare). Tehnica este utilizată frecvent pentru 
modelarea componentelor curbe și tubulare, cum ar fi conductele sau gâturile pistoalelor de sudură. 

Flux de lucru: pregătirea și crearea bazei pistolului de sudură 

 

1. Crearea Resursei Noi (Gun): 

o Alegeți Modeling → Create Part/Resource → New Resource. 

o În dialogul New Resource (resursă nouă), selectați tipul Gun (pistol) și faceți clic pe 
OK. 

o Redenumiți noul obiect (ex.: shank1_user1). 

o Intrarea în Modeling Scope: Selectați shank1_user1 și alegeți Modeling → Set 
Modeling Scope. 

o  
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2. Crearea Căii de Ghidare (Arc): 

o Alegeți Modeling → Create 2D → Create Arc (creare arc). 

o În dialogul Create Arc, introduceți coordonatele pentru: 

▪ Center Point: X: 0, Y: 0, Z: 0. 

▪ Start Point: X: 30, Y: 0, Z: 0. 

▪ End Point: X: 0, Y: 30, Z: 0. 

 

o Faceți OK. 

o Vizualizare: alegeți Zoom To Fit pentru a încadra arcul pe ecran. 

3. Aplicarea operației Sweeping (măturare): 

o Selectați arcul creat (calea de ghidare). 

o Alegeți Modeling → Create 3D → Sweep → Sweep by Circle (măturare după cerc). 

o În dialogul Sweep by Circle: 

▪ Start Diameter: Introduceți 17. 

▪ End Diameter: Introduceți 20. 

o Faceți clic pe Preview, apoi OK. 

 

o Rezultat: este creată o secțiune tubulară curbată, al cărei diametru crește pe parcursul 
lungimii arcului. 

Flux de lucru: modelarea vârfului pistolului (cap) 

1. Crearea Primului Cilindru (Cylinder 1 - Baza Capului): 

o Scop: Crearea unui cilindru la capătul îngust al solidului de sweep. 

o Alegeți Modeling → Create 3D → Cylinder Creation → Create a Cylinder. 

o Radius: 6. Height: 5. 
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o Locate at: alegeți Frame by Circle Center (cadru după centrul cercului) și selectați 
trei puncte în jurul muchiei capătului îngust al solidului curbat. 

o În dialogul de localizare, folosiți Flip Frame (inversare cadru) pentru a vă asigura că 
axa Z (direcția înălțimii) este orientată în afara solidului. Faceți clic pe OK. 

 

o Debifați Maintain Orientation (menține orientarea). Faceți clic pe OK. 

2. Crearea Cilindrului 2 (Cylinder 2 - Secțiunea Principală): 

o Scop: Crearea celui de-al doilea cilindru pe capătul primului. 

o Alegeți Modeling → Create 3D → Cylinder Creation → Create a Cylinder. 

o Radius: 7.5. Height: 11. 

o Locate at: Selectați centrul capătului cilindrului creat anterior. Faceți OK. 

 

3. Crearea Conului (Cone 1 - Vârful Pistolului): 

o Alegeți Modeling → Create 3D → Cone (Con). 

o Lower Radius: 7.5. Upper Radius: 3. Height: 11. 

o Locate at: Selectați centrul capătului celui de-al doilea cilindru. Faceți OK. 
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Flux de lucru: duplicarea și repoziționarea capului 

1. Duplicarea Geometriei Capului: 

o Selectați cele trei solide care formează vârful pistolului (Cylinder 1, Cylinder 2, Cone 
1). 

o Alegeți Modeling → Duplicate Objects (duplicare obiecte). 

o Number along X: 2. X Spacing: 30. 

o Faceți clic pe OK (se creează o copie a vârfului). 

 

2. Repoziționarea Capului Duplicat (Relocate): 

o Selectați geometria capului duplicat. 

o Faceți clic dreapta și alegeți Relocate (repoziționare). 

o From Frame: Selectați centrul vârfului capului duplicat. 

o To Frame: Selectați centrul vârfului capului original (cel atașat solidului curbat). 
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o Asigurați-vă că Maintain orientation (menține orientarea) și Translate only on 
(translatare doar pe) sunt debifate. 

o Faceți clic pe Apply (aplicare) și apoi pe Close (închidere). 

o Rezultat: capul duplicat este plasat la capătul capului original, formând o structură 
lungă și complexă. 

 

Flux de lucru: finalizarea pistolului de sudură 

1. Crearea Solidului de Legătură (Cone 2 și Cylinder 3): 

o Continuați modelarea adăugând segmente conice și cilindrice suplimentare pentru a 
uni capetele (ex.: un Cone cu rază inferioară 8.5 și superioară 11 și un Cylinder cu 
rază 11 și înălțime 100). 

o Utilizați mereu Locate at pentru a plasa noul solid pe centrul capătului celui anterior. 
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2. Crearea celui de-al doilea pistol de sudură (Sweep 2): 

o Repetați procesul de sweeping și modelare a vârfului la celălalt capăt al solidului 
curbat. 

 

3. Salvarea și Ieșirea din Modelare: 

o Selectați obiectul shank1_user1. 

o Alegeți Modeling → End Modeling. 

o Salvați fișierul .cojt în directorul bibliotecii de prototipuri de scule. 

Tehnica Sweeping este indispensabilă pentru modelarea pieselor cu curbură și secțiune variabilă. Prin 
combinarea sweeping-ului cu primitive (Cylinder, Cone) și cu instrumentul Relocate, inginerul poate 
construi pistoale de sudură cu geometrie reproductibilă, necesare pentru simularea realistă a 
proceselor de sudură. 

 

2.5. MODELAREA UNUI OBIECT MAI COMPLEX 
 

2.5.1. Modelarea unui robot simplu pentru cinematică  

Obiectiv: Crearea geometriei pentru toate verigile cinematice (Link – verigă) ale unui robot simplu, 
utilizând primitive geometrice, operații booleene și comenzi de poziționare, ca pregătire pentru 
definirea ulterioară a structurii cinematice. 

Crearea unui robot personalizat implică modelarea fiecărei verigi (ex.: Base – bază, Link1, Link2) 
în cadrul unui singur obiect de tip Robot (robot). Precizia în modelare și poziționare este critică, 
deoarece influențează comportamentul cinematic ulterior. 
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Flux de lucru: pregătirea și crearea bazei robotului (Base link) 

1. Crearea Resursei Robot: 

o Alegeți Modeling → Create Part/Resource → New Resource. 

o În dialogul New Resource, selectați tipul Robot și faceți clic pe OK. 

o Redenumiți noul obiect (ex.: myrobot_user1). 

o Intrarea în Modeling Scope: selectați obiectul și alegeți Modeling → Set Modeling 
Scope. Confirmați cu Yes. 

2. Configurarea unităților: 

o Alegeți Tools → Options → Units. Setați Linear (liniar) la mm. Faceți clic pe OK. 

o Setați Pick Level (nivel de selecție) la Entity (entitate). 

 

3. Crearea solidelor bazei: 

 

o Solidul Principal (Cutie): 

▪ Alegeți Modeling → Create 3D → Box Creation → Create a Box. 

▪ Dimensions: Length: 400, Width: 420, Height: 120. Faceți clic pe OK. 

o Cilindrul 1 (Bază Inferioară): 

▪ Alegeți Modeling → Create 3D → Cylinder Creation → Create a Cylinder. 

▪ Radius: 170. Height: 40. 
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▪ Locate at: Selectați fața superioară a cutiei principale. Bifați Maintain 
Orientation (menține orientarea). Faceți clic pe OK. 

o Cilindrul 2 (Bază Superioară): 

▪ Alegeți Modeling → Create 3D → Cylinder Creation → Create a Cylinder. 

▪ Radius: 110. Height: 110. 

▪ Locate at: Selectați fața superioară a cilindrului 1. Faceți clic pe OK. 

o Salvare: alegeți Modeling → End Modeling și salvați componenta în folderul 
\\Libraries\\modeling_kinematics\\robots. Dacă salvați, reîncărcați obiectul și reintrați 
în Modeling Scope. 

Flux de lucru: crearea verigii 1 (Link1) 

1. Crearea Cutiei Principale LINK1: 

 

o Alegeți Modeling → Create 3D → Box Creation → Create a Box. 

o Locate at: Selectați fața superioară a ultimului cilindru al Bazei. 

o Dimensions: Length: 260, Width: 260, Height: 260. Faceți OK. 

2. Crearea Primului Suport (Bracket 1): 
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o Alegeți Modeling → Create 3D → Box Creation → Create a Box. 

o Locate at: Selectați centrul muchiei superioare (+Y edge) a cutiei Link1. 

o Dimensions: Length: 160, Width: 30, Height: 150. Faceți OK. 

3. Ajustarea Poziției Suportului 1: 

o Selectați noul suport. Alegeți Tools → Placement → Placement Manipulator. 

o Setați Step Size la 15 mm. 

o Folosiți săgeata de translație Y pentru a muta suportul o dată în direcția negativă. 
Faceți OK. 

4. Duplicarea Suportului (Bracket 2): 

o Selectați Suportul 1. 

o Alegeți Modeling → Duplicate Objects. 

o Number along Y: 2. Y Spacing: -230. Faceți OK. 

 

o Rezultat: Sunt create două suporturi care formează o furcă (urechi) pe Link1. 
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Flux de lucru: crearea verigii 2 (Link2) 

 

1. Setarea Cadrului de Lucru (Working Frame): 

o Alegeți Modeling → Set Working Frame. 

o Selectați centrul feței late a uneia dintre "urechile" (suporturile) Link1. Faceți OK. 

 

2. Crearea Corpului Principal (LINK2): 

 

o Cilindru Central (Pivot): 

▪ Alegeți Modeling → Create 3D → Cylinder Creation → Create a Cylinder. 

▪ Locate at: Working Frame. 

▪ Radius: 65. Height: 200. Faceți OK. 

o Cutie Principală: 

▪ Alegeți Modeling → Create 3D → Box Creation → Create a Box. 

▪ Locate at: Working Frame. 

▪ Dimensions: Length: 130, Width: 540 (sau 200 conform notei din prezentare), 
Height: 200. Faceți OK. 
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o Translația Cutiei: Folosiți Placement Manipulator pentru a muta cutia (Ex: 270 mm 
pe axa Y) pentru a o poziționa corect pe cilindrul pivot. 

 

o Unificarea (Unite): Selectați cutia și cilindrul. Alegeți Modeling → Edit → Unite. 
Bifați Delete original entities. Faceți OK. 

3. Crearea Slotului (Slot Cutter): 

o Setarea WF pentru Cutter: Alegeți Modeling → Set Working Frame. Selectați 
centrul feței superioare a solidului Link2 și rotiți Working Frame (Ex: 180 grade pe 
X). Faceți OK. 

o Crearea Cutter-ului (Cutie de Scăzut): 

▪ Alegeți Modeling → Create 3D → Box Creation → Create a Box. 

▪ Locate at: Working Frame. Deselectați Maintain Orientation. 

▪ Dimensions: Length: 300, Width: 140, Height: 210. Faceți OK. 
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o Aplicarea Subtract: 

▪ Alegeți Modeling → Edit → Subtract. 

▪ Subtract entities: Selectați cutia tocmai creată (cutter-ul). 

▪ From entity: Selectați solidul Link2. 

▪ Bifați Delete original entities. Faceți OK. 

o Rezultat: Link2 are acum un slot tăiat în partea superioară. 

Flux de lucru: crearea verigii 3 (Link3) 

 

1. Crearea Cilindrilor: 

o Cilindrul Central (Principal): 

▪ Alegeți Modeling → Create 3D → Cylinder Creation → Create a Cylinder. 

▪ Radius: 67.5. Height: 800. 

▪ Location: Locate at → Frame by 6 Values. Setați Rx: 90 (pentru a-l face 
orizontal). Faceți OK. 

o Cilindrul de Pivotare (Axă): 

▪ Alegeți Modeling → Create 3D → Cylinder Creation → Create a Cylinder. 

▪ Radius: 30. Height: 225. 

▪ Location: Locate at → Frame by 6 Values. Setați Ry: 90 și X: -320 (pentru 
poziționare). Faceți OK. 

o Relocarea Părții de Pivotare: 

▪ Selectați cei doi cilindri tocmai creați. 

▪ Alegeți Tools → Placement → Relocate. 

▪ From Frame: Selectați centrul capătului cilindrului mic. 

▪ To Frame: Selectați centrul muchiei interioare a furcii Link2. 

▪ Bifați Maintain orientation și Translate only on (pe Z). Faceți OK. 
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Flux de lucru: crearea verigilor 4 (Link4) și 5 (Link5) 

1. Crearea LINK4 (Capăt Rotund): 

 

o Cilindru: Creați un cilindru (Ex: Radius: 64, Height: 30). Locate at: Capătul lung 
al Link3. 

o Cutie: Creați o cutie (Ex: 130x130x130). Locate at: Centrul cilindrului. 

 

o Cilindru Rotunjire: Creați un cilindru (Ex: Radius: 65, Height: 130). Locate at: 
Centrul cutiei. Rotiți-l cu 90 grade pe Rx. 

o Unificarea: Unificați (Unite) cutia și cilindrul de rotunjire. 

o Tăierea Slotului: Creați o cutie de tăiere (Ex: 200x40x200) și aplicați operația 
Subtract din solidul Link4.  
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2. Crearea LINK5 (Încheietură): 

 

o Cilindru Principal: Creați un cilindru (Ex: Radius: 65, Height: 40). Locate at: 
Centrul razei interioare a solidului Link4. 

o Cutie (Extensie): Creați o cutie (Ex: 40x40x135). Locate at: Centrul cilindrului. 

 

Flux de lucru: crearea verigii 6 (Link6) și finalizarea 

1. Crearea LINK6 (Flanșă Finală): 

 

o Creați un cilindru (Ex: Radius: 25, Height: 15). Locate at: Capătul cutiei Link5. 
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2. Salvarea și Ieșirea: 

o Selectați myrobot_user1. 

o Alegeți Modeling → End Modeling. 

o Salvați fișierul .cojt în folderul bibliotecii de roboți 
(\Libraries\modeling_kinematics\robots folder). 

3. Mutarea Prototipului în Bibliotecă: 

o În Navigation Tree, navigați la folderul Libraries. 

o Executați Check Out pe biblioteca Robots (dacă nu e deja). 

o Trageți și plasați prototipul myrobot_user1 din folderul utilizatorului în biblioteca 
Robots. 

Modelarea întregii structuri într-un singur obiect de tip Robot (robot) reprezintă pasul pregătitor 
pentru definirea arborelui cinematic în Kinematics Editor (editor cinematic). Prin modelarea 
geometrică precisă a fiecărei verigi (Link), se creează baza necesară pentru simularea mișcării 
complexe a robotului. 
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3. NOȚIUNI INTRODUCTIVE DE CINEMATICĂ 

 

 

Cinematica este fundamentul oricărei simulări robotice sau al oricărui dispozitiv mecanic în Process 
Simulate. Aceasta definește modul în care piesele modelului (numite Link (verigă) sau Links 
(verigi)) sunt conectate între ele prin articulații (Joint (articulație) / Joints (articulații)), stabilind 
gradele de libertate și regulile de mișcare ale ansamblului. 

 

3.1.CONTEXTUL CINEMATICII 
 

3.1.1. Aplicație Cinematică Simplă 

Obiectiv: Revizuirea și înțelegerea structurii unei cinematici simple (ex.: demo-ul two blocks) prin 
examinarea Kinematics Editor și manipularea articulațiilor cu Joint Jog. 

Înțelegerea modului în care arată o structură cinematică finalizată este primul pas. Demo-ul two 
blocks ilustrează cel mai simplu sistem cinematic: două verigi conectate printr-o singură articulație 
rotoare (revolută). 

 

Flux de lucru: încărcarea și vizualizarea studiului demo 

1. Pregătirea Proiectului: 

o Închideți proiectul curent (File → Close Project). Confirmați cu Yes, apoi No la 
actualizarea eMServer. 

o Alegeți File → Open Project și selectați Project_209S. 

2. Încărcarea Studiului: 

o Navigați în Navigation Tree la colecția Studies → folderul de studiu alocat (Ex: 
Line... StudyFolder) → model kinematics folder. 

o Executați Clic dreapta pe folderul model kinematics și alegeți Check Out (bifați with 
Hierarchy). 

o Executați Clic dreapta pe studiul two blocks demo și alegeți Load in Standard 
Mode. 
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3. Izolarea Obiectului: 

o În Object Tree, executați Clic dreapta pe obiectul two blocks demo și alegeți Display 
Only. 

o Alegeți View → Zoom to Fit. 

Flux de lucru: examinarea cinematicii (Kinematics Editor) 

1. Accesarea Editorului: 

o Selectați obiectul two blocks demo. 

o Alegeți Kinematics → Kinematics Editor. 

o Observație: Editorul afișează o structură ierarhică simplă: Link 1 și Link 2, conectate 
printr-o articulație. 

2. Închiderea: 

o Închideți dialogul Kinematics Editor. 

Flux de lucru: testarea mișcării (Joint Jog) 

1. Jogging: 

o Selectați obiectul two blocks demo. 

o Alegeți Kinematics → Joint Jog. 

o Utilizați cursorul interactiv (Steering gear icon) pentru a mișca articulația și a observa 
mișcarea relativă a Link 2 față de Link 1 în Graphic Viewer. 

2. Finalizarea: 

o Închideți dialogul Joint Jog. 

Aplicația confirmă că o structură cinematică funcțională necesită minimum două verigi (Links) și o 
articulație (Joint). Verigile sunt piese rigide, iar articulația definește axa și tipul de mișcare permis 
(rotație sau translație). 

 

3.1.2. Cinematică Simplă (partea 1) 

Obiectiv: Definirea de la zero a cinematicii pentru un obiect modelat (two blocks) prin crearea 
verigilor (Links) și a unei articulații rotoare de tip Revolute Joint (articulație revolută). 

Crearea cinematicii implică identificarea componentelor care se mișcă independent (verigile) și 
specificarea modului în care acestea se rotesc sau se translatează una față de cealaltă (articulațiile). 

Flux de lucru: pregătirea studiului și a modelului 

1. Încărcarea Studiului: 

o Reîncărcați studiul two blocks (versiunea nemodelată) din folderul model kinematics 
(dacă nu este deja deschis). 



Proiectarea și Simularea Sistemelor de Producție în Process Simulate 

64 
 

o Asigurați-vă că Working Folder este setat corect. 

2. Setarea Scope-ului de Modelare: 

o În Object Tree, selectați obiectul two blocks (Ex: two_blocks_user1). 

o Alegeți Modeling → Set Modeling Scope. Confirmați cu OK. 

3. Deschiderea Kinematics Editor: 

o Selectați obiectul two_blocks_user1. 

o Alegeți Kinematics → Kinematics Editor. 

 

Flux de lucru: definirea verigilor (Links) 

1. Crearea Link-ului Părinte (Link 1): 

o În Kinematics Editor, alegeți Create Link (Creează Verigă). 

o În Graphic Viewer, selectați cutia inferioară (care va fi Link 1, veriga părinte). 

o În dialogul Link Properties, faceți OK (acceptând numele implicit LNK1). 

2. Crearea Link-ului Copil (Link 2): 

o În Kinematics Editor, alegeți Create Link din nou. 

o În Graphic Viewer, selectați cutia superioară (care va fi Link 2, veriga copil). 

o Faceți OK (acceptând numele implicit LNK2). 

Flux de lucru: crearea articulației (Joint) 

1. Selecția Perechii Link-uri: 

o În Kinematics Editor, selectați LNK1 (Link Părinte). 

o Țineți apăsată tasta [Ctrl] și selectați LNK2 (Link Copil). 

o Notă: O articulație se poate crea și trăgând o linie de la Link-ul părinte la cel copil. 

2. Crearea Articulației: 

o În Kinematics Editor, alegeți Create Joint (Creează Articulație). 

o Observație: Sistemul folosește tipul implicit Revolute (rotoare) și o axă implicită (de 
obicei de la 0,0,0 la 0,0,100 pe Z). 

o În dialogul Joint Properties, faceți OK. 
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Flux de lucru: testarea cinematicii (Joint Jog) 

1. Închiderea Kinematics Editor: 

o Închideți dialogul Kinematics Editor. 

2. Jogging: 

o Selectați obiectul two_blocks_user1. 

o Alegeți Kinematics → Joint Jog. 

 

o Accesați opțiunile Options în dialogul Joint Jog și mutați Slider sensitivity spre low 
(pentru un control mai fin). Faceți OK. 

 

o Utilizați cursorul interactiv (Steering gear icon) al articulației J1 pentru a testa rotația. 

3. Finalizarea: 

o Faceți clic pe Reset, apoi Close. 

Partea 1 a activității a stabilit scheletul cinematic funcțional al obiectului two blocks. În acest moment, 
obiectul se poate mișca în conformitate cu definiția articulației J1 (articulație rotoare), care permite 
rotația verigii 2 în jurul verigii 1. 

 

3.1.3. Cinematică simplă (partea 2) 

Obiectiv: Editarea proprietăților articulației nou create, în special setarea limitelor de mișcare (Limits 
(limite)) pentru a restricționa unghiul de rotație. 
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Configurarea limitelor de mișcare este esențială pentru a preveni mișcările fizic imposibile și pentru 
a reduce riscul de coliziuni în simulare. Aceste limite definesc intervalul unghiular sau liniar permis 
pentru o articulație. 

Flux de lucru: editarea proprietăților articulației 

1. Asigurarea Scope-ului de Modelare: 

o Dacă ați ieșit din Modeling Scope (domeniul de modelare) în activitatea precedentă, 
selectați obiectul și alegeți Modeling → Set Modeling Scope. 

o Deschideți din nou Kinematics Editor. 

2. Editarea Articulației: 

o În Kinematics Editor, faceți dublu clic (double-Clic) pe săgeata articulației J1. 

o În dialogul Joint Properties, faceți clic pe Expand Dialog (extindere dialog). 

3. Setarea Limitelor: 

o În secțiunea Limits, selectați Constant pentru Limits type. 

o Pentru High Limit (limită superioară), introduceți 360. 

o Pentru Low Limit (limită inferioară), păstrați valoarea implicită 0. 

o Lăsați neschimbate valorile Speed (Viteză) și Acceleration (Accelerație). 

 

o Faceți OK. 

4. Închiderea: 

o Închideți dialogul Kinematics Editor. 

Flux de lucru: testarea mișcării cu limite (Joint Jog) 

1. Jogging: 

o Alegeți Kinematics → Joint Jog. 
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o Utilizați cursorul articulației J1 pentru a roti Link 2 (veriga 2). 

o Observație: Câmpurile Lower Limit (0.00) și Upper Limit (360.00) sunt acum 
afișate în dialog. 

o Încercați să rotiți obiectul dincolo de limitele setate; mișcarea ar trebui să fie 
restricționată la intervalul [0, 360] grade. 

Prin definirea limitelor de mișcare, se finalizează o definiție cinematică simplă, dar robustă. Această 
metodă reprezintă baza pentru definirea tuturor gradelor de libertate (DOF (degrees of freedom)) și 
a restricțiilor asociate pentru roboți și dispozitive complexe. 

 

3.2. NOȚIUNI DE BAZĂ ÎN CINEMATICĂ 
 

3.2.1. Adăugarea articulațiilor la un obiect simplu 

Obiectiv: Definirea întregii structuri cinematice (Links (verigi) și Joints (articulații)) pentru un 
dispozitiv cu mai multe componente (ex.: o ușă cu mâner), incluzând atât articulația de rotație a ușii 
(balama), cât și articulația mânerului. 

Un mecanism cu mai multe componente, cum ar fi o ușă, este definit prin mai multe verigi și 
articulații. Veriga de bază (Base Link (verigă de bază), respectiv tocul ușii (Doorframe (tocul ușii))) 
este fixă, în timp ce ușa propriu-zisă și mânerul (Handle (mâner)) sunt verigi mobile, fiecare având 
o articulație rotoare proprie. 

Flux de lucru: pregătirea studiului și inserarea componentei 

1. Încărcarea Studiului: 

o Navigați la folderul de lucru al utilizatorului. 

o Executați clic dreapta (Clic dreapta) pe studiul temp și alegeți Load in Standard 
Mode. Răspundeți No la salvarea modificărilor studiului precedent. 

2. Inserarea Componentei: 

o În Object Tree, alegeți Modeling → Insert Component from File. 

o Navigați la directorul de prototipuri (Ex: \Libraries\model_kinematics\toolprototypes 
folder). 

o Selectați fișierul de geometrie al ușii (Ex: room_door_geo_user1.cojt). 

o Faceți clic pe Open. 
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3. Setarea Scope-ului de Modelare: 

 

o Selectați obiectul ușii (Ex: room_door_geo). 

o Alegeți Modeling → Set Modeling Scope. Confirmați cu OK. 

o Alegeți Kinematics → Kinematics Editor. 

Flux de lucru: definirea verigilor (Links) 

Notă: Modelul conține deja geometria separată pentru tocul ușii (Doorframe), ușa propriu-zisă și 
mâner (Handle), care vor deveni verigile cinematice (Links). 

1. Crearea Link-ului Tocului (Base Link): 

o În Kinematics Editor, alegeți Create Link. 

o Selectați geometria Tocului ușii în Graphic Viewer (acesta este Link-ul Părinte). 

o Faceți OK în Link Properties. 

2. Crearea Link-ului Ușii (Link 1): 

o Alegeți Create Link. 

o Selectați geometria Ușii propriu-zise în Graphic Viewer. 

o Faceți OK. 

3. Crearea Link-ului Mânerului (Link 2): 

o Alegeți Create Link. 

o Selectați geometria Mânerului în Graphic Viewer. 

o Faceți OK. 

Flux de lucru: definirea articulației rotoare a ușii (Joint 1 – balama) 

1. Trasarea legăturii dintre verigi (Link): 

o În Kinematics Editor, trageți o linie de la Link-ul Părinte (Tocul ușii) la Link-ul 
Copil (Ușa). 

2. Definirea axei: 

o În dialogul Joint Properties (proprietăți articulație), bifați Revolute pentru Joint 
Type. 
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o Faceți clic pe From (pentru axă), apoi selectați de două ori o linie de-a lungul axei 
balamalei (ex.: muchia balamalei) în Graphic Viewer. 

o Observație: Dacă apare o eroare, ignorați-o momentan și continuați cu setarea. 

o (Sfat: Poate fi necesară ajustarea valorii Z a punctului To al axei pentru a asigura o 
lungime suficientă). 

3. Setarea Limitelor: 

o Faceți clic pe Expand Dialog (extindere dialog). 

o Adăugați limitele (ex.: High Limit (limită superioară) = 110, Low Limit (limită 
inferioară) = 0). 

o Setați Speed (viteză) și Acceleration (accelerație) (ex.: 90). 

o Faceți OK. 

Flux de lucru: definirea articulației rotoare a mânerului (Joint 2) 

1. Trasarea legăturii dintre verigi (Link): 

o În Kinematics Editor, trageți o linie de la Link-ul Părinte (Ușa) la Link-ul Copil 
(Mânerul). 

2. Definirea Axelor și a Tipului: 

o Bifați Revolute pentru Joint Type. 

o Faceți clic pe From (pentru axă) și selectați de două ori o linie de-a lungul axei de 
rotație a mânerului (ex.: centrul cilindrului mânerului). 

o (Sfat: Poate fi necesară ajustarea valorii X a punctului To al axei). 

3. Setarea Limitelor: 

o Setați limitele de rotație necesare pentru mâner (Ex: High Limit la 45, Low Limit la 
0). 

o Faceți OK. 

4. Închiderea Editorului: 

o Închideți dialogul Kinematics Editor. 

Flux de lucru: utilizare și salvare 

1. Testarea (Joint Jog): 

o Executați Clic dreapta pe obiectul ușii și alegeți Joint Jog. 

o Testați ambele articulații (J1 și J2) pentru a vă asigura că funcționează corect. Închideți 
dialogul. 
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2. Definirea Pozițiilor (Pose Editor): 

o Executați Clic dreapta pe obiectul ușii și alegeți Pose Editor. 

o Definiți pozițiile OPEN și CLOSED (similar cu Cap. 4.2.a). 

o Testați saltul între poziții (Jump). Închideți dialogul. 

3. Salvarea Modelării: 

o Selectați obiectul ușii. 

o Alegeți Modeling → End Modeling. 

Modelul de ușă cu două articulații este un exemplu reprezentativ de mecanism cu mai multe verigi. 
Prin definirea fiecărui Link și a axei fiecărui Joint, se obține un dispozitiv funcțional, pregătit pentru 
utilizare în operații de simulare. 

 

3.3. FUNDAMENTELE INTERDEPENDENȚEI ARTICULAȚIILOR  
 

3.3.1. Axe principale și parametri de sincronizare  

Obiectiv: Crearea cinematicii pentru o unealtă robotică (ex.: un clește de prindere) și configurarea 
unei Joint Dependency (dependență de articulație) pentru a sincroniza mișcarea brațelor cleștelui, 
prin definirea unei Leading Joint (articulație conducătoare). 

În uneltele robotice (clești, grippere), mișcarea a două sau mai multe articulații trebuie adesea corelată 
printr-o relație fixă (ex.: ambele brațe ale unui clește se mișcă simetric). Această sincronizare este 
realizată prin Joint Dependency, în care o articulație urmăritoare (Follow Joint (articulație 
urmăritoare)) urmează mișcarea unei articulații conducătoare (Leading Joint) printr-un Follow 
Factor (factor de urmărire). 

Flux de lucru: pregătirea și definirea cinematicii cleștelui 

1. Încărcarea Studiului: 

o Navigați în Navigation Tree la folderul Studies → model kinematics. 

o Executați clic dreapta (Clic dreapta) pe studiul gun_lf și alegeți Load in Standard 
Mode. 

2. Setarea Scope-ului de Modelare: 

o Selectați obiectul cleștelui (Ex: gun_lf_user1). 

o Alegeți Modeling → Set Modeling Scope. 
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3. Deschiderea Kinematics Editor: 

o Alegeți Kinematics → Kinematics Editor. 

o Setați Pick Level la Entity. 

4. Definirea verigilor (Links): 

 

o Link Părinte (Body): Creați un Link pentru solidul portocaliu (corpul cleștelui). 
Numiți-l Body. 

o Link Braț Superior: Creați un Link pentru solidul verde (brațul superior). Numiți-l 
Upr_arm. 

o Link Braț Inferior: Creați un Link pentru solidul roz (brațul inferior). Numiți-l 
Lwr_arm. 

o Notă: Structura cinematică așteptată este: Body este părinte pentru Upr_arm (J1) și 
Lwr_arm (J2). 

5. Crearea Articulațiilor (Joints): 

o Joint 1 (Braț Superior): Trageți o linie de la Body la Upr_arm. Definiți o articulație 
Revolute (rotoare) folosind axa de rotație a brațului superior. 

o Joint 2 (Braț Inferior): Trageți o linie de la Body la Lwr_arm. Definiți o articulație 
Revolute folosind axa de rotație a brațului inferior. 
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o Testare: Închideți Kinematics Editor și testați ambele articulații cu Joint Jog. 
Închideți Joint Jog. 

Flux de lucru: setarea dependenței de articulație (Joint Dependency) 

1. Accesarea Proprietăților Articulației Următoare: 

o Redeschideți Kinematics Editor. 

o În editor, selectați articulația care va urma (Follow Joint), adică J2 (brațul inferior). 

o Faceți clic pe pictograma Joint Dependency (Dependență de Articulație). 

2. Definirea Funcției: 

o În dialogul Joint Dependency, schimbați opțiunea Joint Dependency la Joint 
Function (funcție de articulație). 

o La Joint Name (nume articulație), selectați J1 (articulația brațului superior), care este 
Leading Joint. 

3. Calcularea și Setarea Follow Factor: 

o Follow Factor (factor de urmărire) este raportul dintre intervalul de mișcare al 
articulației urmăritoare și intervalul de mișcare al articulației conducătoare. 

o Dacă ambele brațe se rotesc în aceeași direcție simetric, factorul este +1.0. Dacă se 
rotesc în direcții opuse (un braț se deschide, celălalt se închide), factorul este -1.0. 

o În dialogul Joint Function, faceți clic pe Multiplication (multiplicare). 

o Introduceți valoarea factorului calculat (Ex: -2.13 sau valoarea corectă determinată de 
geometria cleștelui). 

o Faceți clic pe Apply și Close. 

o Închideți Kinematics Editor. 

Flux de lucru: verificarea mișcării sincronizate 

1. Testarea Mișcării: 

o Selectați obiectul cleștelui și alegeți Kinematics → Joint Jog. 

o Acum, doar articulația conducătoare (J1) va avea un cursor activ. Mișcați J1 (brațul 
superior). 

o Observație: Articulația J2 (brațul inferior) se mișcă automat în raport cu J1, asigurând 
mișcarea de deschidere/închidere sincronizată a cleștelui. 

2. Ajustarea Factorului: 

o Repetați procesul (Set Modeling Scope → Kinematics Editor → J2 → Joint 
Dependency) și schimbați Follow Factor la o valoare opusă (Ex: de la negativ la 
pozitiv). 
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o Testați din nou mișcarea cleștelui și observați diferența (brațele se pot mișca acum în 
aceeași direcție). 

3. Finalizarea și Salvarea: 

o Executați clic dreapta pe obiect și alegeți Home. 

o Alegeți Modeling → End Modeling. 

Joint Dependency este o tehnică esențială de optimizare a modelării robotice. Aceasta reduce 
numărul de variabile de control (de la două articulații la una), simplificând programarea și asigurând 
o mișcare sincronizată a uneltelor (ex.: deschidere/închidere simetrică). 

 

3.4. INTRODUCERE ÎN MECANISMELE BIELĂ-MANIVELĂ  
 

3.4.1. Buclă Cinematică 

Obiectiv: Definirea unei bucle cinematice (ex.: mecanism RPRR de tip Slider Crank (mecanism 
bielă-manivelă), care simulează un piston) pentru un obiect simplu, utilizând asistentul Create Crank 
(creează manivelă). 

Buclele cinematice sunt structuri închise (ex.: mecanisme cu patru bare, pistoane), în care mișcarea 
unei verigi (Link) depinde de poziția tuturor celorlalte verigi. Asistentul Create Crank simplifică 
definirea acestor mecanisme, automatizând crearea verigilor (Links) și a articulațiilor (Joints). 

Flux de lucru: pregătirea studiului și a modelului 

1. Încărcarea Studiului: 

o Navigați în Navigation Tree la colecția Studies → folderul de studiu alocat → model 
kinematics folder. 

o Executați clic dreapta (Clic dreapta) pe studiul dump și alegeți Load in Standard 
Mode. 

2. Izolarea Obiectului și Setarea Scope-ului: 

o În Object Tree, executați clic dreapta pe obiectul pistonului (ex.: dump2) și alegeți 
Display Only. 

 



Proiectarea și Simularea Sistemelor de Producție în Process Simulate 

74 
 

o Observație: Asigurați-vă că sunt afișate cele trei cadre (Frames) critice, care definesc 
axele de rotație. 

o Alegeți Modeling → Set Modeling Scope. Confirmați cu OK. 

Flux de lucru: utilizarea asistentului Create Crank (RPRR) 

1. Lansarea Asistentului: 

o Alegeți Kinematics → Kinematics Editor. 

o În Kinematics Editor, faceți clic pe pictograma Create Crank (Creează Manivelă). 

o În dialogul Create Crank, selectați tipul de manivelă (ex.: RPRR Slider Crank). 

o Faceți clic pe Next. 

2. Definirea axelor articulațiilor (Joint Axes): 

o Pe diagrama de legătură, faceți clic pe punctul corespunzător (ex.: punctul de 
deasupra Coupler Link (veriga de cuplare)). 

 

o În Graphic Viewer, selectați cadrul echivalent (ex.: fr1, fr2, fr3) care reprezintă axa 
articulației. Repetați procesul pentru celelalte două puncte de axă de pe diagrama de 
legătură. 

 

o Observație: Un triunghi este desenat în Graphic Viewer între punctele selectate, 
reprezentând axele mecanismului. 
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o Faceți clic pe Next de două ori (acceptând setarea implicită Without offset (fără 
offset) pentru articulația prismatică). 

 

3. Corelarea verigilor (Links): 

o Pe diagrama de legătură, selectați veriga fixă (Fixed Link (verigă fixă)). 

o În Graphic Viewer, selectați entitățile echivalente (ex.: cele două piese laterale fixe 
de pe podea) care formează Fixed Link. 

 

o Repetați procesul pentru: 

▪ Input Link (verigă de intrare): Selectați solidele pistonului imediat adiacente 
verigii fixe. 
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▪ Coupler Link (verigă de cuplare): Selectați solidele următoare (ex.: solidul 
pistonului) adiacente verigii de intrare. 

▪ Output Link (verigă de ieșire): Selectați solidul final. 

4. Finalizarea: 

o Faceți clic pe Finish. 

o Rezultat: Arborele cinematic este definit automat, incluzând verigile (Links) și 
articulațiile (Joints) necesare. 

 

Flux de lucru: testarea și salvarea 

1. Testarea Mișcării (Joint Jog): 

o Închideți Kinematics Editor. 

o Executați clic dreapta pe obiect și alegeți Joint Jog. 

o Deplasați articulația pistonului pentru a vedea cum se mișcă mecanismul (bucla). 

o Faceți Reset și închideți dialogul. 
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2. Salvarea: 

o Executați clic dreapta pe obiect și alegeți Home. 

o Alegeți Modeling → End Modeling. 

Asistentul Create Crank reduce complexitatea definirii buclelor cinematice. Metoda este utilizată 
frecvent pentru modelarea mecanismelor de tip piston, a cleștilor de sudură și a altor dispozitive cu 
mișcare dependentă. 

 

3.5. STRUCTURI CINEMATICE RAMIFICATE 
 

3.5.1. Definirea cinematicii sculei robotului (partea 1) 

Obiectiv: Definirea cinematicii pentru o unealtă robotică complexă (ex.: un pistol de sudură cu 
piston), care implică atât ramificare (brațe), cât și buclă cinematică (mecanismul pistonului), 
utilizând asistentul Create Crank (creează manivelă). 

Pistoalele de sudură sunt adesea mecanisme de tip crank (manivelă) care includ un piston (o buclă 
cinematică) ce comandă deschiderea și închiderea brațelor. Această activitate combină conceptele 
prezentate anterior: definirea verigilor, ramificarea cinematică și integrarea unei bucle. 

Flux de lucru: pregătirea studiului și a componentelor 

1. Încărcarea Studiului: 

o Navigați la folderul Studies → model kinematics. 

o Executați clic dreapta (Clic dreapta) pe studiul gun_geo1 și alegeți Load in Standard 
Mode. 

2. Izolarea Obiectului și Setarea Scope-ului: 

o Executați clic dreapta pe obiectul pistolului (ex.: gun_geo_user1) și alegeți Display 
Only. 

o Observație: Modelul ar trebui să afișeze componentele pistolului (brațe, piston, 
cilindru). Acestea sunt deja create ca verigi (Links) separate (lwr_arm, upr_arm, 
rod, cyl, bracket). 

o Alegeți Modeling → Set Modeling Scope. 
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Flux de lucru: definirea buclei cinematice (piston RPRR) 

1. Lansarea Asistentului Crank: 

o Alegeți Kinematics → Kinematics Editor. 

o Faceți clic pe Create Crank (creează manivelă). 

o Selectați tipul de manivelă Slider (RPRR). Faceți clic pe Next. 

 

2. Definirea punctelor de axă (Frames (cadre)): 

o Pe diagrama de legătură, selectați punctul corespunzător. 

o Selectați cadrul 1 (Output Link): În Object Tree, selectați fr1 (cadrul dintre brațul 
inferior albastru și piston). 

o Selectați cadrul 2 (Fixed Link): În Object Tree, selectați fr2 (cadrul de fixare pe 
corpul portocaliu). 

o Selectați cadrul 3 (Input Link): În Object Tree, selectați fr3 (cadrul dintre brațul 
superior galben și corpul portocaliu). 

o Observație: Un triunghi este desenat între cele trei cadre. 

o Faceți clic pe Next de două ori (pentru a crea bucla Without offset (fără offset)). 

3. Corelarea verigilor existente (Existing Link (verigă existentă)): 

 

o Pe diagrama de legătură, selectați Fixed Link. 

o În dialog, faceți clic pe Existing Link (verigă existentă). 

o Selectați din lista derulantă veriga corespunzătoare (ex.: lwr [brațul inferior 
portocaliu]). 
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o Repetați procesul pentru celelalte verigi, corelându-le cu componentele pistolului 
conform diagramei: 

▪ Output Link: upr (brațul superior galben). 

▪ Input Link: rod (tija pistonului magenta). 

▪ Coupler Link: cyl (cilindrul pistonului albastru). 

 

o Faceți clic pe Finish. 

o Rezultat: Bucla cinematică RPRR este definită. 

Flux de lucru: crearea articulației rotoare (ramificare) 

1. Definirea Articulației (Braț Inferior): 

o În Kinematics Editor, trageți o linie de la Link-ul părinte (ex.: base [care ar trebui să 
existe ca link părinte] sau un link de bază implicit) la link-ul lwr (brațul inferior). 

o Definiți această articulație ca Revolute (rotoare), utilizând axa de rotație a brațului 
inferior. 

o Setați axa de rotație utilizând cadrele (Ex: fr3) sau puncte de pe Link-ul lwr. 

o Faceți OK. 

Flux de lucru: testarea buclei cinematice 

1. Testarea (Joint Jog): 

o Închideți Kinematics Editor. 

o Executați clic dreapta pe obiect și alegeți Joint Jog. 

o Observație: Ar trebui să existe doar două articulații care pot fi deplasate cu Joint Jog: 
articulația de la bază și articulația prismatică (tija pistonului). 

o Deplasați articulațiile cu Joint Jog pentru a vedea cum se mișcă brațele cleștelui. 

2. Avertisment: În acest moment, brațele cleștelui pot să nu se deschidă și să nu se închidă 
simetric, deoarece sunt definite ca Output Link și Fixed Link, nu ca articulații dependente 
(Follow Joints). Mișcarea poate părea neobișnuită. 
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Definirea cinematicii unei unelte robotice este adesea un exercițiu de rezolvare a problemelor, 
combinând ramificarea (pentru a atașa cleștele la baza robotului) și buclele (pentru a simula pistonul). 
Acesta pune bazele pentru următoarea etapă, care este definirea mișcării simetrice a brațelor. 

 

3.5.2. Definirea cinematicii sculei robotului (partea 2) 

Obiectiv: Sincronizarea mișcării celor două brațe ale pistolului de sudură (cleștelui) prin utilizarea 
unei Joint Function (funcție de articulație) cu un Follow Factor (factor de urmărire) negativ. 

Deși bucla cinematică a pistolului este definită, mișcarea brațelor (maxilarelor) trebuie echilibrată 
pentru deschidere și închidere simetrică. Acest lucru se realizează prin definirea unei articulații ca 
fiind dependentă de o alta, folosind o funcție de multiplicare cu un factor negativ (ex.: -2.0). 

Flux de lucru: crearea unei articulații sincronizate (Balanced Joint (articulație echilibrată)) 

1. Deschiderea Editorului: 

o Porniți Process Simulate (modul conectat) și deschideți proiectul. 

o Încărcați studiul care conține pistolul de sudură (Ex: gun_geo). 

o Alegeți Modeling → Set Modeling Scope. 

o Alegeți Kinematics → Kinematics Editor. 

2. Identificarea Articulațiilor: 

o Identificați articulația care va fi Leading Joint (articulație conducătoare) (ex.: J1, 
articulația brațului superior) și articulația care va fi Follow Joint (articulație 
urmăritoare) (ex.: J2, articulația brațului inferior). 

3. Accesarea Dependenței: 

o În Kinematics Editor, selectați articulația urmăritoare (Follow Joint, ex.: J2). 

o Faceți clic pe pictograma Joint Dependency (dependență de articulație). 

4. Setarea Funcției de Urmărire: 

o În dialogul Joint Dependency, bifați Joint Function (funcție de articulație). 

o Pentru Joint Name, selectați articulația conducătoare (ex.: J1). 

o Faceți clic pe Multiplication (multiplicare) și introduceți factorul de multiplicare dorit 
(ex.: -2.0 sau -2.13). 

o Explicație: Factorul negativ asigură că brațul inferior se mișcă în direcția opusă 
(deschidere/închidere) față de brațul superior, menținând simetria. 

o Faceți clic pe Apply și Close. 
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Flux de lucru: testarea mișcării echilibrate 

1. Testarea cu Joint Jog: 

o Închideți Kinematics Editor. 

o Executați clic dreapta (Clic dreapta) pe obiectul pistolului și alegeți Joint Jog. 

o Observație: Ar trebui să existe o singură articulație care poate fi deplasată cu Joint 
Jog (Leading Joint). 

o Deplasați articulația conducătoare. Cele două brațe ar trebui să se miște în direcții 
opuse, asigurând deschiderea și închiderea simetrică. 

2. Editarea Funcției: 

o Redeschideți Kinematics Editor și schimbați factorul de multiplicare de la -2 la 2. 
Testați din nou. 

o Observație: Ambele brațe se vor mișca în aceeași direcție, demonstrând rolul 
factorului negativ. Reveniți la valoarea funcțională. 

Flux de lucru: salvarea modificărilor 

1. Salvarea Modelării: 

o Executați clic dreapta pe obiectul pistolului și alegeți Home. 

o Alegeți Modeling → End Modeling. 

o Salvați fișierul. 

 

Utilizarea Joint Function cu un Follow Factor negativ este o tehnică standard pentru a obține o 
unealtă de sudură echilibrată (Balanced Joint Tool (unealtă cu articulație echilibrată)). Aceasta 
simplifică programarea ulterioară, deoarece un singur semnal de control (Leading Joint) comandă 
întreaga mișcare simetrică a brațelor uneltei. 

 

3.6. DEFINIREA VITEZEI ȘI A ACCELERAȚIEI 
 

Obiectiv: Această secțiune descrie pașii necesari pentru configurarea parametrilor dinamici ai 
componentelor cinematice (în acest caz, un clește de sudură, gun). Definirea corectă a valorilor de 
Speed (viteză) și Acceleration (accelerație) este esențială pentru simularea realistă a timpilor de ciclu 
în Process Simulate. 

Introducerea valorilor de viteză și accelerație 

Pentru a defini valorile de viteză și accelerație ale unei articulații, urmați procedura de mai jos: 

1. Selectați entitatea geometrică a sculei (gun_geo). 

2. Accesați meniul Modeling și selectați Set Modeling Scope. 
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3. Deschideți editorul cinematic din Kinematics → Kinematics Editor. 

4. În fereastra editorului, faceți dublu clic (double-Clic) pe articulația (Joint) vizată. 

5. Extindeți fereastra de proprietăți cu Expand Dialog (extindere dialog) și introduceți valorile 
maxime dorite pentru Speed (viteză) și Acceleration (accelerație). Pentru testarea limitelor 
maxime, se poate utiliza valoarea 9999. 

6. Confirmați prin OK și închideți editorul. 

Testarea și validarea comportamentului cinematic 

După definirea parametrilor, este necesară verificarea acestora prin simularea unei operații de 
dispozitiv: 

1. Utilizați Pose Editor pentru a crea două poziții distincte: TEST1 și TEST2. 

2. Creați o operație nouă de tip New Device Operation (operație nouă de dispozitiv) între cele 
două poziții. 

3. În fereastra Operation Properties (proprietăți operație), observați cum modificarea valorilor 
de viteză și accelerație influențează direct timpul de simulare (Duration (durată)). O viteză 
mai mică va crește automat timpul necesar deplasării între TEST1 și TEST2. 

4. Utilizați Sequence Editor (editor de secvență) pentru a rula și analiza fluiditatea mișcării. 

Finalizarea și salvarea prototipului 

Odată ce parametrii sunt validați, obiectul trebuie salvat ca prototip pentru a fi utilizat în studii 
viitoare: 

● Copierea prototipului: În arborele de obiecte (Object Tree), copiați entitatea gungeo și 
redenumiți-o conform standardului proiectului (ex.: gungeoservoUSERNUMBER). 

● Finalizarea modelării: Ieșiți din modul de editare selectând Modeling → End Modeling. 

● Salvarea în bibliotecă: Navigați în folderul de bibliotecă corespunzător (ex.: 
\\Libraries\\modelkinematics\\guns) și salvați fișierul. Dacă lucrați integrat cu Teamcenter, 
utilizați funcția File → Save As și asociați noul nume elementului din baza de date. 

 

3.7. DEFINIREA UNUI OBIECT CA PISTOL PNEUMATIC DE SUDURĂ ÎN PUNCTE 
 

3.7.1. Definirea unui obiect ca pistol pneumatic de sudură în puncte 

Obiectiv: Utilizarea comenzii Tool Definition (definirea uneltei) pentru a desemna un obiect 
cinematic (un clește de sudură) ca pistol pneumatic de sudură în puncte, incluzând definirea pozițiilor 
cheie (Poses (poziții)) și a cadrelor de referință: TCP (Tool Center Point (punct central al uneltei)) 
și Mount Frame (cadrul de montare). 
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Un pistol de sudură pneumatic necesită definirea a trei poziții standard de operare (CLOSE, 
SEMIOPEN, OPEN) pentru a simula ciclul de sudură. De asemenea, trebuie definite două cadre 
critice: TCP (Tool Center Point) și Mount Frame (cadrul de montare). 

Flux de lucru: pregătirea și definirea pozițiilor cheie (Poses (poziții)) 

1. Pregătirea Modelului: 

o Asigurați-vă că obiectul pistolului (ex.: gungeo) este în Modeling Scope (domeniul 
de modelare) și că structura cinematică (Links (verigi) și Joints (articulații)) este deja 
definită (inclusiv dependența de articulație, dacă este cazul). 

 

o Utilizați Kinematics → Home pentru a readuce pistolul la poziția inițială (HOME, 
de obicei J1 = 0). 

o Verificați că unitățile liniare sunt setate la mm (Tools → Options → Units). 

 

 

2. Crearea Poziției CLOSE: 

o Alegeți Kinematics → Pose Editor. 

o Faceți clic pe New. Lăsați valoarea articulației la 0. 

o Redenumiți poziția (ex.: CLOSE). Faceți OK. 
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3. Crearea Poziției SEMIOPEN: 

o Faceți clic pe New. 

o Folosiți săgețile sau Joint Jog pentru a seta articulația la o valoare specifică (ex.: -15 
grade), care reprezintă deschiderea parțială. 

o Redenumiți poziția (ex.: SEMIOPEN). Faceți OK. 

4. Crearea Poziției OPEN: 

o Faceți clic pe New. 

o Setați articulația la o valoare care corespunde deschiderii maxime (ex.: -30 grade). 

o Redenumiți poziția (ex.: OPEN). Faceți OK. 

5. Testarea și Resetarea: 

o Testați saltul între pozițiile create (Jump). 

o Faceți clic pe Reset pentru a reveni la poziția HOME. Închideți Pose Editor. 

Flux de lucru: crearea cadrelor critice (TCP și Mount Frame) 

1. Crearea TCP Frame (cadrul TCP): 

o Alegeți Modeling → Create Frame → Frame by 6 values (creare cadru prin 6 
valori). 

o Faceți clic pe Position și selectați punctul de pe vârful (cap) din mijlocul brațului 
inferior al pistolului. (Acesta este punctul unde se realizează sudura). 

o Redenumiți cadrul în Object Tree ca tcp. 

o Alegeți Modeling → Edit → Set as Preserved Object (setează ca obiect păstrat). 

 

2. Crearea Mount Frame (cadrul de montare): 

o Alegeți Modeling → Create Frame → Frame by 6 values. 
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o Selectați originea obiectului (punctul de montare al pistolului pe flanșa robotului). 

o Redenumiți cadrul în Object Tree ca mnt. 

o Alegeți Modeling → Edit → Set as Preserved Object. 

Flux de lucru: aplicarea Tool Definition 

1. Lansarea Tool Definition: 

o Selectați obiectul pistolului. 

o Alegeți Kinematics → Tool Definition. 

2. Configurarea Parametrilor: 

o În dialogul Tool Definition, selectați Gun din lista Tool Type (tip unealtă). 

o În caseta TCP Frame (Cadru TCP), selectați cadrul tcp (creat anterior). 

o În caseta Base Frame (Cadru Bază), selectați cadrul mnt (creat anterior). 

o Observație: Câmpul Do not check for collisions with (nu verifica coliziunile cu) 
poate fi lăsat necompletat. În aplicații industriale, aici se pot specifica vârfurile 
pistolului pentru a evita verificările de coliziune nerelevante. 

o Faceți clic pe OK. 

3. Salvarea: 

o Alegeți Modeling → End Modeling. 

Definirea unui obiect ca Gun pneumatic permite sistemului să recunoască și să utilizeze pozițiile 
OPEN/CLOSE/SEMIOPEN în operațiile de sudură, asigurând simularea corectă a ciclului de 
sudură în puncte. 

 

3.7.2. Definirea unui obiect ca pistol de sudură în puncte de tip servo  

Obiectiv: Utilizarea comenzii Tool Definition (definirea uneltei) pentru a desemna un obiect ca 
Servo Gun (pistol servo), care nu necesită poziții predefinite (Poses (poziții)). 
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Pistoalele de sudură servo sunt controlate direct de robot (prin valorile articulațiilor) și nu folosesc 
poziții discrete (Poses) ca referință. Prin urmare, la definirea unui Servo Gun, nu sunt necesare 
pozițiile OPEN, SEMIOPEN și CLOSE. 

 

Flux de lucru: pregătirea și crearea cadrelor 

1. Pregătirea Modelului: 

o Încărcați obiectul pistolului servo (ex.: gungeoservo) și intrați în Modeling Scope 
(domeniul de modelare). 

o Atenție: Asigurați-vă că nu există poziții (Poses) definite pe acest model. 

2. Crearea TCP Frame (Cadrul de Sudură): 

o Creați un cadru la vârful brațului inferior al pistolului. Redenumiți-l tcp. 

o Setați-l ca Preserved Object (obiect păstrat). 
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3. Crearea Mount Frame (Cadrul de Montare): 

o Creați un cadru la originea de montare a pistolului. Redenumiți-l mnt. 

o Setați-l ca Preserved Object (obiect păstrat). 

 

Flux de lucru: aplicarea Tool Definition (Servo Gun) 

1. Lansarea Tool Definition: 

o Selectați obiectul pistolului. 

o Alegeți Kinematics → Tool Definition. 

2. Configurarea Parametrilor: 

o În dialogul Tool Definition, selectați Servo Gun din lista Tool Type (tip unealtă). 

o În caseta TCP Frame (cadru TCP), selectați cadrul tcp. 

o În caseta Base Frame (cadru de bază), selectați cadrul mnt. 

o Faceți clic pe OK. 

3. Salvarea: 

o Alegeți Modeling → End Modeling. 

Definirea unui pistol ca Servo Gun nu necesită poziții (Poses), deoarece controlul uneltei se 
realizează direct prin valorile articulațiilor, specific caracteristicilor sistemelor servo. 

 

3.7.3. Definirea unui obiect ca pistolet de sudură cu arc 

Obiectiv: Utilizarea comenzii Tool Definition (definirea uneltei) pentru a defini un obiect ca pistolet 
de sudură cu arc, folosind o distanță de Stick Out (ieșirea sârmei) pentru poziționarea corectă a TCP 
(Tool Center Point). 

Pistoalele de sudură cu arc sunt unelte care necesită un punct de referință (TCP) și un cadru de 
montare (Mount Frame). TCP-ul trebuie poziționat la distanța de Stick Out (distanța de ieșire a 
sârmei din duză), necesară pentru simularea corectă a procesului de sudură cu arc. 
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Flux de lucru: pregătirea și crearea cadrelor 

1. Încărcarea Modelului: 

o Încărcați obiectul pistolului (ex.: stgun330user1.cojt) și intrați în Modeling Scope 
(domeniul de modelare). 

2. Crearea TCP Frame (cu Stick Out): 

o Alegeți Modeling → Create Frame → Frame by 6 values (creare cadru prin 6 
valori). 

 

o Faceți clic în câmpul Reference și selectați punctul din mijlocul vârfului (tip) 
pistolului. 

 

o Observație: Valorile de poziție relativă ar trebui să fie acum zero. 
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o În dialogul Create Frame by 6 values, rotiți orientarea pe axa X (ex.: 180 grade) 
pentru a alinia axa Z (care ar trebui să indice direcția sârmei) înapoi spre robot. 

o Deplasați poziția pe axa Z (ex.: 20 mm) pentru a reprezenta distanța de Stick Out 
(ieșirea sârmei). 

 

o Faceți OK. 

o Redenumiți cadrul tcp și setați-l ca Preserved Object (obiect păstrat). 

3. Crearea Mount Frame (Cadrul de Montare): 

o Creați un cadru la originea de montare a pistolului. 

 

o Redenumiți-l mnt și setați-l ca Preserved Object. 

Flux de lucru: aplicarea Tool Definition (Arc-Weld Torch) 

1. Lansarea Tool Definition: 

o Selectați obiectul pistolului. 

o Alegeți Kinematics → Tool Definition. 

2. Configurarea Parametrilor: 

o În dialogul Tool Definition, selectați Gun din lista Tool Type (tip unealtă). 

o În caseta TCP Frame (cadru TCP), selectați cadrul tcp. 

o În caseta Base Frame (cadru de bază), selectați cadrul mnt. 

o Faceți clic pe OK (acceptând crearea de cinematică și poziții dummy (fictive), dacă nu 
există). 
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3. Salvarea: 

o Alegeți Modeling → End Modeling. 

 

Definirea unui pistolet de sudură cu arc ca tip Gun, cu un TCP poziționat la distanța de Stick Out, 
permite programarea punctelor de sudură la suprafața piesei și asigură atingerea distanței de lucru 
corecte în simulare. 

 

3.7.4.  Definirea unui obiect ca sculă de debavurare  

Obiectiv: Utilizarea comenzii Tool Definition (definirea uneltei) pentru a desemna un obiect ca 
unealtă generică de debavurare, prin definirea cadrelor TCP (Tool Center Point) și Mount Frame 
(cadrul de montare). 

Sculele de debavurare (sau de prelucrare) sunt, de regulă, unelte simple, fără cinematică internă, însă 
necesită o definire precisă a TCP-ului (Tool Center Point (punct central al uneltei)), pentru a simula 
corect traiectoriile de prelucrare. 

Flux de lucru: pregătirea și crearea cadrelor 

1. Încărcarea Modelului: 

o Navigați la folderul de studiu (ex.: temp study) și încărcați-l (Load in Standard 
Mode). 

o Inserați componenta uneltei de debavurare (ex.: rcb24033deburringtooluser1.cojt) în 
studiu și intrați în Modeling Scope (domeniul de modelare). 

2. Crearea TCP Frame: 

o Alegeți Modeling → Create Frame → Frame by 6 values (creare cadru prin 6 
valori). 

o În dialog, selectați punctul din mijlocul vârfului uneltei de debavurare. 

o Selectați o referință (ex.: un punct pe corpul uneltei) și rotiți orientarea pe axa X (ex.: 
180 grade) pentru a alinia axa Z a TCP-ului pe direcția de prelucrare. 

 

o Redenumiți cadrul tcp și setați-l ca Preserved Object (obiect păstrat). 
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3. Crearea Mount Frame (Cadrul de Montare): 

o Creați un cadru la originea de montare a uneltei. 

 

o Redenumiți-l mnt și setați-l ca Preserved Object. 

Flux de lucru: aplicarea Tool Definition (Deburring Tool) 

1. Lansarea Tool Definition: 

o Selectați obiectul uneltei de debavurare. 

o Alegeți Kinematics → Tool Definition. 

2. Configurarea Parametrilor: 

o În dialogul Tool Definition, selectați Gun din lista Tool Type (tip unealtă). 

o Observație: Deși este o unealtă de debavurare, dacă nu este clasificată ca Gripper 
sau Paint Gun, poate fi definită sub tipul generic Gun (sau Tool, în funcție de 
configurația sistemului). 

o În caseta TCP Frame (cadru TCP), selectați cadrul tcp. 

o În caseta Base Frame (cadru de bază), selectați cadrul mnt. 

o Lăsați câmpul de coliziuni necompletat. 

o Faceți clic pe OK. 

 

 

 

 



Proiectarea și Simularea Sistemelor de Producție în Process Simulate 

92 
 

3. Salvarea: 

o Alegeți Modeling → End Modeling. 

Definirea uneltelor generice de prelucrare (cum ar fi cea de debavurare) ca tip Gun, cu un TCP definit 
corect, permite utilizarea lor în operații cu traiectorii continue, tratând vârful uneltei ca punct de 
contact esențial. 

 

3.7.5. Definirea unui obiect ca pistol de vopsit 

Obiectiv: Utilizarea comenzii Tool Definition (definirea uneltei) pentru a desemna un obiect ca 
pistol de vopsit, prin definirea unui TCP poziționat la distanța de pulverizare (Stick Out (distanță de 
pulverizare)) și a cadrului vârfului duzei (Tip Frame (cadrul vârfului)). 

Pistoalele de vopsit necesită un TCP poziționat la distanța optimă de pulverizare (ex.: 200 mm), 
numită Stick Out. De asemenea, este necesar un Tip Frame (cadrul vârfului) care marchează vârful 
fizic al duzei. 

Flux de lucru: pregătirea și crearea cadrelor 

1. Încărcarea Modelului: 

o Inserați componenta pistolului de vopsit (ex.: paintgun1.cojt) și intrați în Modeling 
Scope (domeniul de modelare). 

2. Crearea Paint Gun Tip Frame (Vârful Duzei): 

o Alegeți Modeling → Create Frame → Frame by 6 values (creare cadru prin 6 
valori). 

o Selectați punctul din mijlocul duzei pistolului. 

o Redenumiți cadrul paintguntip și setați-l ca Preserved Object (obiect păstrat). 

3. Crearea TCP Frame (cadrul de vopsire – Stick Out): 

o Alegeți Modeling → Create Frame → Frame by 6 values (creare cadru prin 6 
valori). 

o În câmpul Reference, selectați cadrul paint_gun_tip (pentru a-i prelua orientarea). 

o Rotiți orientarea pe axa X (ex.: 180 grade). 

o Deplasați poziția pe axa Z (ex.: 200 mm) pentru a seta distanța de Stick Out (distanța 
de lucru efectivă). 



Proiectarea și Simularea Sistemelor de Producție în Process Simulate 

93 
 

 

o Redenumiți cadrul tcp și setați-l ca Preserved Object (obiect păstrat). 

4. Crearea Mount Frame (Cadrul de Montare): 

o Creați un cadru la originea de montare. 

 

o Redenumiți-l mnt și setați-l ca Preserved Object (obiect păstrat). 

Flux de lucru: aplicarea Tool Definition (Paint Gun) 

1. Lansarea Tool Definition: 

o Selectați obiectul pistolului de vopsit. 

o Alegeți Kinematics → Tool Definition. 

2. Configurarea Parametrilor: 

o În dialog, selectați Paint Gun din lista Tool Type (tip unealtă). 

o În caseta TCP Frame (cadru TCP), selectați cadrul tcp. 

o În caseta Base Frame (cadru de bază), selectați cadrul mnt. 

o În caseta Tip Frame (cadrul vârfului), selectați cadrul paintguntip. 

o Faceți clic pe OK. 
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3. Salvarea: 

o Alegeți Modeling → End Modeling. 

Clasificarea unei unelte ca Paint Gun permite sistemului să interpreteze corect TCP-ul ca punct de 
pulverizare efectiv, esențial pentru simularea proceselor de vopsire și pentru estimarea acoperirii. 

 

3.7.6. Definirea unui obiect ca gripper  

Obiectiv: Definirea unui obiect cinematic (ex.: un clește cu brațe mobile) ca Gripper (clește de 
prindere), prin specificarea entităților de prindere (Gripping Entities (entități de prindere)) și a 
valorilor de offset. 

Un Gripper (clește de prindere) este o unealtă robotică utilizată pentru atașarea și detașarea pieselor. 
Definirea unui gripper necesită specificarea zonelor de prindere (Gripping Entities), pentru ca 
mecanismul automat de detecție să poată atașa geometria piesei la TCP în timpul simulării. 

Flux de lucru: pregătirea și definirea cinematicii cleștelui 

1. Încărcarea Modelului: 

o Inserați componenta cleștelui (ex.: box_gripper.cojt) și intrați în Modeling Scope 
(domeniul de modelare). 

2. Definirea Cinematicii (Dacă nu este definită): 

o Deschideți Kinematics Editor. 

o Definiți veriga de bază (Base Link (verigă de bază)) (corpul cleștelui) și verigile 
(Links (verigi)) pentru brațul stâng și brațul drept. 

o Definiți articulații prismatice (Prismatic Joints (articulații prismatice)) între baza 
cleștelui și brațe (ex.: j1 și j2 pe axa X). 

o Testare: Testați mișcarea brațelor cu Joint Jog. 

3. Definirea Pozițiilor: 

o Folosiți Pose Editor pentru a defini pozițiile OPEN (deschis) și CLOSE (închis) 
pentru clește. 

4. Crearea TCP și Mount Frame: 

o Creați și denumiți cadrul de montare mnt și cadrul TCP tcp. Setați-le ca Preserved 
Object (obiect păstrat). 

Flux de lucru: aplicarea Tool Definition (Gripper) 

1. Lansarea Tool Definition: 

o Selectați obiectul cleștelui. 

o Alegeți Kinematics → Tool Definition. 
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2. Configurarea Parametrilor: 

o În dialog, selectați Gripper (clește de prindere) din lista Tool Type (tip unealtă). 

o Setați TCP Frame (cadru TCP) la tcp și Base Frame (cadru de bază) la mnt. 

3. Definirea entităților de prindere (Gripping Entities): 

o În zona dedicată Gripping Entities, faceți clic și selectați din Graphic Viewer sau 
Object Tree cilindrii/suprafețele de pe brațe care vor intra efectiv în contact cu piesa. 

o Offset: Lăsați valoarea implicită (ex.: 1 mm). 

o Importanță: Entitățile de prindere sunt folosite pentru a calcula automat piesele care 
trebuie atașate la TCP (un mecanism care atașează piesele care se ciocnesc cu 
entitățile de prindere, ținând cont de offset). 

4. Finalizarea: 

o Faceți clic pe OK. 

o Alegeți Modeling → End Modeling. 

Definirea unui obiect ca Gripper este esențială pentru simularea operațiilor de tip pick-and-place. 
Entitățile de prindere (Gripping Entities) definite corect asigură atașarea și detașarea automată a 
pieselor în timpul simulării, pe baza coliziunii geometrice și a valorii de offset. 

 

3.8. ADĂUGAREA CINEMATICII LA UN ROBOT SIMPLU 
 

3.8.1. Adăugarea Cinematicii la un Model de Robot 

Obiectiv: Definirea structurii cinematice complete a unui robot cu 6 grade de libertate (DOF) prin 
crearea succesivă a celor 7 verigi (Links) și a celor 6 articulații rotoare (Revolute Joints), inclusiv 
setarea axelor, a limitelor și a vitezei. 

Un robot industrial standard cu 6 DOF este definit de 7 verigi (Link Base, Link 1... Link 6) și 6 
articulații (Joint 1... Joint 6). Acest proces necesită precizie în separarea geometriei în verigi și 
definirea axelor de rotație pentru fiecare articulație. 

Flux de lucru: pregătirea studiului și a robotului 

1. Încărcarea Modelului: 

o Încărcați studiul de lucru (ex.: temp study). 

o Inserați componenta robotului modelat anterior (ex.: myrobot_geo_user1.cojt) din 
folderul \\Libraries\\modeling_kinematics\\robots. 

o Executați clic dreapta (Clic dreapta) pe obiectul robotului și alegeți Display Only. 

2. Setarea Scope-ului de Modelare: 

o Selectați obiectul robotului. 
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o Alegeți Modeling → Set Modeling Scope. Confirmați cu Yes. 

o Viziune: Vizualizați lanțul cinematic: Base → Link1 (J1) → Link2 (J2) → ... → Link6 
(J6). 

Flux de lucru: definirea verigilor cinematice (7 Links) 

1. Accesarea Editorului: 

o Alegeți Kinematics → Kinematics Editor. 

o În editor, selectați Create Link (Creează Verigă). 

2. Definirea Verigii BASE: 

o Selectați cele trei solide inferioare care formează baza robotului. 

o În dialogul Link Properties, tastați base pentru Name. Faceți OK. 

3. Definirea Verigilor Link 1, Link 2, ... Link 6: 

o Repetați procesul de definire a Link-ului pentru fiecare segment al robotului, în ordine 
succesivă, de la bază spre flanșă. 

o Pas: Selectați următoarele solide care formează Link 1, Link 2, etc. 

o Observație: Numele implicite (ex.: LNK1, LNK2) sunt atribuite automat sau pot fi 
redenumite explicit (ex.: lnk1, lnk2 etc., pentru verigile 1–6). 

o Rezultat: Veți avea un total de 7 verigi definite în Kinematics Editor. 

Flux de lucru: definirea articulațiilor rotoare (6 Joints) 

 

Notă: Metoda preferată este Method 1 (selectarea a două puncte pe geometrie) pentru a defini axa 
fiecărei articulații. 

1. Configurare: Setați Pick Intent la Snap. 
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2. Joint 1 (Base - Link1): 

 

o Selectați Link-ul base și lnk1 (Base și Link 1). 

o Faceți clic pe Create Joint (Creează Articulație). 

o Axă: Faceți clic pe From și selectați două puncte (ex.: centrul cilindrului inferior) care 
definesc axa de rotație verticală. 

o Limitele: Setați Limits type la Constant. High Limit: 180. Low Limit: -180. 

o Viteză: Setați Speed la 110, Acceleration la 9999. Faceți OK. 

3. Joint 2 (Link1 - Link2): 

  

o Selectați lnk1 și lnk2. Faceți clic pe Create Joint. 

o Axă: Selectați cele două capete ale axei de rotație (ex.: centrul capetelor cilindrilor 
laterali). 

o Limitele: Setați High Limit: 70. Low Limit: -70. Speed: 110. Faceți OK. 

4. Joint 3 (Link2 - Link3): 

 

o Selectați lnk2 și lnk3. Faceți clic pe Create Joint. 

o Axă: Selectați axa de rotație. 

o Limitele: Setați High Limit: 70. Low Limit: -70. Speed: 110. Faceți OK. 
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5. Joint 4 (Link3 - Link4): 

„ 

o Selectați lnk3 și lnk4. Faceți clic pe Create Joint. 

o Axă: Selectați axa de rotație. 

o Limitele: Setați High Limit: 90. Low Limit: -190. Speed: 170. Faceți OK. 

6. Joint 5 (Link4 - Link5): 

 

o Selectați lnk4 și lnk5. Faceți clic pe Create Joint. 

o Axă: Selectați axa de rotație. 

o Limitele: Setați High Limit: 110. Low Limit: -110. Speed: 170. Faceți OK. 

7. Joint 6 (Link5 - Link6): 

 

o Selectați lnk5 și lnk6. Faceți clic pe Create Joint. 

o Axă: Atenție: Aceeași axă (J4) poate fi folosită pentru definirea articulațiilor J4 și J6 
în unele configurații. 

o Limitele: Setați High Limit: 340. Low Limit: -340. Speed: 240. Faceți OK. 

8. Finalizare: 

o Alegeți Modeling → End Modeling pentru a salva cinematicii în prototipul robotului. 
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Notă Despre Dependență: 

● Deși, în aplicații industriale, anumite articulații (ex.: J2 și J3) pot avea limite dependente 
(variabile), în această activitate ele sunt definite ca fiind Constant. 

Modelarea cinematică a unui robot cu 6 DOF este finalizată. Robotul este acum un obiect funcțional 
în simulare, capabil de mișcare complexă, pregătit pentru programarea traiectoriilor prin cinematică 
inversă. 

 

3.8.2. Utilizarea Cinematicii Directe pentru a Muta Robotul 

Obiectiv: Testarea cinematicii robotului nou creat utilizând instrumentul de cinematică directă, Joint 
Jog, și familiarizarea cu poziția HOME. 

Cinematica directă implică introducerea directă a valorilor articulațiilor, iar sistemul calculează 
poziția finală a TCP-ului. Joint Jog este instrumentul principal pentru această metodă, fiind util 
pentru depanare și pentru verificarea rapidă a limitelor. 

Flux de lucru: testarea mecanismului 

1. Pregătirea: 

o Setați Pick Level la Component. 

2. Lansarea Joint Jog: 

o Executați clic dreapta (Clic dreapta) pe obiectul robotului și alegeți Kinematics → 
Joint Jog. 
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3. Testarea Articulațiilor: 

o Deplasați cursoarele (sliders) pentru fiecare articulație (J1 la J6) și observați mișcarea 
verigilor (Links) corespunzătoare în Graphic Viewer. 

o Observație: 

▪ Valorile curente afișate în Joint Jog sunt relative la poziția HOME (definită 
ca poziția robotului în momentul creării cinematicii, unde toate articulațiile 
sunt la 0). 

▪ Limitele de mișcare definite în Kinematics Editor sunt aplicate. 

4. Revenirea la HOME: 

o Faceți clic pe Reset în dialogul Joint Jog. 

o Atenție: Asigurați-vă că faceți clic pe Reset înainte de a închide dialogul, pentru a 
returna robotul în poziția sa de referință. 

 

Testarea cinematicii cu Joint Jog validează funcționalitatea articulațiilor, confirmă limitele setate și 
stabilește poziția de referință HOME, necesară pentru toate operațiile de programare ulterioare. 

 

3.9. CREAREA ȘI UTILIZAREA DISPOZITIVELOR CU CINEMATICĂ INVERSĂ 
 

3.9.1. Adăugarea unui sistem de coordonate al sculei 

Obiectiv: Transformarea unui dispozitiv cinematic cu 6 articulații într-un obiect de tip Robot 
(capabil să utilizeze Inverse Kinematics (cinematică inversă, IK)) prin definirea cadrului final al 
uneltei (TOOLFRAME (cadru de unealtă)). 

Pentru ca un lanț cinematic să fie utilizat cu cinematica inversă (IK), Process Simulate trebuie să 
cunoască cadrul de lucru al vârfului (end-effector). Acest lucru se realizează prin crearea și atașarea 
unui TOOLFRAME (cadru de unealtă) la veriga finală a robotului, ceea ce activează instrumente 
precum Robot Jog. 

Flux de lucru: pregătirea și definirea TOOLFRAME 

1. Continuarea Modelării: 

o Asigurați-vă că obiectul robotului (ex.: myrobot_geo) este încărcat și că ați intrat în 
Modeling Scope (domeniul de modelare). 
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2. Examinarea Structurii: 

o Alegeți Kinematics → Kinematics Editor și examinați arborele cinematic. Robotul 
trebuie să aibă cele 6 articulații rotoare definite. 

 

3. Pregătirea Selecției: 

o În Graphic Viewer, faceți zoom pe încheietura robotului. 

 

o Setați Pick Level la Entity și Pick Intent la Snap. 
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4. Crearea TOOLFRAME: 

o În Kinematics Editor, faceți clic pe pictograma Create Toolframe (creează cadru de 
unealtă). 

o În Graphic Viewer, selectați (cu Snap) punctul din mijlocul capătului verigii finale 
(ex.: lnk6, veriga de culoare cian). 

o În dialogul Create Toolframe care apare, verificați că opțiunea Attach to link 
(atașează la verigă) este evidențiată. 

o Selectați din nou veriga lnk6 pentru a confirma atașarea. 

o Faceți clic pe OK. 

 

o Rezultat: Mai multe cadre (inclusiv TOOLFRAME, BASEFRAME, REFFRAME, 
TCPF) sunt create automat și adăugate la nodul robotului în Object Tree. 

5. Salvarea: 

o Alegeți Modeling → End Modeling. 

Definirea TOOLFRAME este pasul prin care un dispozitiv cinematic este transformat într-un obiect 
Robot recunoscut de Process Simulate, permițând utilizarea cinematicii inverse (IK) și a 
instrumentelor de programare robotică. 

 

 

 

3.9.2. Utilizarea Cinematicii Inverse pentru a Muta Robotul 

Obiectiv: Deplasarea robotului utilizând Cinematica Inversă (prin instrumentul Robot Jog) și crearea 
unei traiectorii simple de mișcare robotică. 

Robot Jog (Deplasare Robot) este interfața pentru Cinematică Inversă. În loc să deplaseze 
articulațiile individual, utilizatorul manipulează TCP-ul robotului direct în spațiul 3D, iar software-
ul calculează configurația articulațiilor necesare. 
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Flux de lucru: deplasarea cu Robot Jog (IK) 

1. Lansarea Robot Jog: 

o Executați clic dreapta (Clic dreapta) pe obiectul robotului și alegeți Robot Jog 
(Deplasare Robot). 

 

o Observație: Acest dialog este disponibil doar pentru obiectele care au 
TOOLFRAME definit. 

2. Manipularea IK: 

o În Graphic Viewer, prindeți și trageți Manipulator Frame (cadrul roșu-verde-
albastru al TCP-ului) asociat robotului. 

o Observație: Întregul robot se mișcă, iar articulațiile sale se ajustează automat pentru 
a menține punctul TCP-ului în locația specificată. 

o Lăsați dialogul Robot Jog deschis. 

Flux de lucru: crearea unei operații robotice (Robotic Operation) 

1. Crearea Operației: 

o Alegeți Operations → New Operation → New Generic Robotic Operation 
(Operație Robotică Generică Nouă). 

o Introduceți un nume (ex.: generic_robotic_Op). Setați Scope la Operation Root. 

o Faceți clic pe OK. 

2. Adăugarea Locației 1 (Via Point): 

o Asigurați-vă că operația generic_robotic_Op este selectată în Operation Tree. 

o Alegeți Operations → Path Editing → Add Current Location (Adaugă Locația 
Curentă). 
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o Rezultat: O nouă locație, numită via1, este adăugată traiectoriei robotului. 

 

3. Adăugarea Locației 2: 

o Utilizați Robot Jog pentru a muta TCP-ul robotului într-o poziție diferită în spațiul 
de lucru. 

o Alegeți Operations → Path Editing → Add Location After (Adaugă Locație După) 
locația via1. 

o Rezultat: O a doua locație (via2) este salvată. 

Flux de lucru: simulare și testare 

1. Revenirea la Poziția HOME: 

o Alegeți Kinematics → Home (pentru a readuce robotul la J1=0, J2=0...). 

2. Simularea Traiectoriei: 

o În Sequence Editor, faceți clic pe Play Simulation Forward (Rulează Simulare 
Înainte). 

o Observație: Robotul se mișcă de la poziția HOME, trece prin via1 și ajunge la via2. 

o După rulare, faceți clic pe Jump Simulation to Start (salt la începutul simulării). 

Robot Jog și Add Current Location sunt elementele de bază pentru programarea online (directă) a 
robotului. Acestea permit inginerului să definească traiectorii funcționale folosind cinematica inversă, 
fără a introduce manual valorile articulațiilor. 

 

3.9.3. Noțiuni avansate de cinematică inversă 

Obiectiv: Definirea cinematicii pentru dispozitive de manipulare mai complexe, cum ar fi un 
transbordor (AGV) sau o macara, utilizând articulații prismatice și rotoare, și pregătirea lor pentru 
utilizarea IK. 

Cinematica inversă (IK) nu este limitată la roboți cu articulații revolute (rotoare). Vehiculele ghidate 
automat (AGV (Automated Guided Vehicle)), macaralele și alte sisteme de manipulare sunt adesea 
definite cu o combinație de articulații prismatice (translație pe X, Y, Z) și revolute (rotație în jurul 
axei Z). 
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Flux de lucru: definirea cinematicii transbordorului (AGV/Crawler) 

1. Viziunea Cinematică: 

o Un transbordor necesită de obicei 3 articulații independente pentru poziționarea pe 
podea: X (prismatic), Y (prismatic), Rz (rotativ în jurul Z). 

2. Flux de lucru: modelare 

o Creați un nou obiect crawler (șasiu) și un obiect crawler_top (pat). 

o Crawler: Creați 4 empty links (verigi goale) (ex.: lnk1–lnk4). 

o Joint X (lnk1 → lnk2): Articulație Prismatic (prismatică) de-a lungul axei X. 

o Joint Y (lnk2 → lnk3): Articulație Prismatic (prismatică) de-a lungul axei Y. 

o Joint Rz (lnk3 → lnk4): Articulație Revolute (rotoare) în jurul axei Z. 

o Atașarea geometriei: Adăugați geometria șasiului la veriga finală (ex.: lnk4). 

o TOOLFRAME: Adăugați un TOOLFRAME la veriga finală (ex.: lnk4), poziționat 
la un punct de referință (ex.: pe podea, între roțile din față). 
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3. Crawler Top (Piesa Montată): 

o Definiți patul (crawler_top) ca o unealtă separată. 

o Adăugați o articulație lift (prismatică pe Z) între cele două verigi ale sale. 

o Această abordare modulară permite manipularea separată a înălțimii patului. 

Flux de lucru: definirea cinematicii macaralei (Overhead Crane) 
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1. Viziunea Cinematică (XYZ-Prismatic): 

o O macara aeriană necesită 3 articulații prismatice. 

o Joint X (lnk1 → lnk2): Articulație Prismatic pe axa X (deplasare pe lungimea șinei). 

o Joint Y (lnk2 → lnk3): Articulație Prismatic pe axa Y (translație pe lățimea podului). 

o Joint Z (lnk3 → lnk4): Articulație Prismatic pe axa Z (ridicare/coborâre a 
cablului/cârligului). 

o TOOLFRAME: Adăugați un TOOLFRAME la veriga finală (ex.: lnk4), la punctul 
de prindere al cârligului. 

2. Sincronizare: Setați limitele și testați mișcarea cu Joint Jog. 

Flux de lucru: finalizarea și sincronizarea eMS 

1. Adăugarea TOOLFRAME: Asigurați-vă că fiecare dispozitiv (AGV, Macara) are un 
TOOLFRAME definit pe veriga finală. 

2. Sincronizarea cu Baza de Date: 

o Alegeți File → eMServer Selective Update. 

o Bifați Resources (Resurse) și Operations (Operații). 

o Faceți clic pe OK. 

o Rezultat: Noile prototipuri de roboți/dispozitive sunt salvate în baza de date și pot fi 
utilizate în orice studiu din proiect. 
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Modelarea cinematicii inverse pentru sisteme de manipulare non-robotice este o extensie directă a 
principiilor IK. Prin utilizarea articulațiilor prismatice, inginerul poate crea o reprezentare funcțională 
a oricărui sistem XYZ, XYZ-R sau RRRRRR, esențială pentru simularea întregului flux de materiale. 
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4. MODELARE ȘI CINEMATICĂ 

 

 

4.1.CĂI DE RULARE, DEFINIREA AXELOR EXTERNE 
 

4.1.1. Prezentare generală a creării unei șine simple 

Obiectiv: Crearea unui prototip simplu de șină (rail) și definirea cinematicii acestuia, utilizând o 
singură articulație prismatică (J1) pentru translația de-a lungul șinei. 

Șinele, macaralele și poziționatoarele sunt axe cinematice externe (External Axes) care extind zona 
de lucru a unui robot. O șină simplă este compusă din veriga fixă (rail) și un cărucior mobil (carriage). 

Flux de lucru: Pregătirea studiului și a resursei 

1. Deschiderea Prototipului Nou: 

o Încărcați studiul de lucru (de ex. temp study). 

o Alegeți Modeling → Create Part/Resource → New Resource. Selectați 
ToolPrototype. 

o Redenumiți noul obiect (de ex. rail1_user1). 

o Intrați în Modeling Scope. 

2. Crearea Geometriei: 

o Rail (șina fixă): creați o cutie (Box) (de ex. 15000 × 800 × 1000). 

o Carriage (căruciorul mobil): creați o a doua cutie (Box) (de ex. 800 × 1000 × 1000). 

o Poziționare: Utilizați Placement Manipulator pentru a poziționa căruciorul la un 
capăt al șinei. 

Flux de lucru: Definirea cinematicii șinei (o articulație prismatică) 

1. Definirea Verigilor: 

o Link 1 (Rail): Creați un Link pentru geometria șinei (aceasta este veriga fixă, baza). 

o Link 2 (Carriage): Creați un Link pentru geometria căruciorului (aceasta este veriga 
mobilă). 

2. Definirea Articulației (J1 - Translație): 

o Trageți o linie de la Rail Link la Carriage Link. 

o Setați Joint Type la Prismatic (Prismatică). 
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o Axă: definiți axa de translație de-a lungul șinei (de ex. de la (0,0,0) la (100,0,0) pe axa 
X). 

o Setați limitele de mișcare (de ex. Low Limit: 0, High Limit: 14000). 

3. Finalizarea: 

o Alegeți Modeling → End Modeling. 

o Salvați prototipul în \sysroot\Libraries\modeling_kinematics\toolprototypes folder. 

Prototipul de șină creat este acum un dispozitiv cinematic cu o axă externă (J1, prismatică), permițând 
mișcarea robotului (montat pe cărucior) de-a lungul unei traiectorii liniare. 

 

4.1.2. Alte mecanisme bielă-manivelă (inclusiv cele excentrice) 

Obiectiv: Examinarea și definirea cinematicii pentru mecanisme complexe de tip Slider Crank 
(manivelă glisantă), inclusiv cele cu decalaj (offset). 

Pe lângă RPRR, există și alte configurații complexe (de ex. RRRR, PRRR). Mecanismele cu decalaj 
(offset) implică o complexitate cinematică suplimentară, deoarece articulația prismatică nu se 
deplasează direct de-a lungul axei verigii fixe. 

Flux de lucru: Inserarea și examinarea exemplelor de tip crank 

1. Inserarea Componentelor: 

o Inserați fișierele .cojt din folderul \sysroot\Libraries\model_kinematics\more_kin (de 
ex. rrrp.cojt, rprr_offset.cojt etc.) în studiu. 

o Folosiți Fast Placement pentru a le aranja pe ecran. 

2. Examinarea Funcțiilor: 

o Executați Joint Jog pe fiecare obiect pentru a observa modul în care se mișcă. 

o Deschideți Kinematics Editor și examinați Joint Kinematics Functions (funcțiile 
cinematice ale articulației), pentru a vedea relațiile matematice care definesc mișcarea 
buclei. 

Flux de lucru: Modelarea unui slider RPRR cu offset 

1. Pregătirea: 

o Selectați obiectul fără cinematică (Ex: rprr_offset_geo) și intrați în Modeling Scope. 

2. Lansarea Asistentului Crank: 

o Alegeți Kinematics → Kinematics Editor → Create Crank. 

o Selectați RPRR. Faceți Next. 
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3. Definirea Axelor (Puncte) și Offset: 

o Selectați cele trei puncte de axă (fr1, fr2, fr3) pe diagrama de legătură și în Graphic 
Viewer. 

o Faceți Next. Bifați With offset (Cu decalaj) pentru a include decalajul articulației 
prismatice. 

o Definiți punctele From și To ale axei de offset (Ex: selectați capetele unei linii de 
referință). 

o Faceți Next. 

 

4. Corelarea Verigilor: 

o Selectați Existing Link (Link Existent) și corelați fiecare verigă (Fixed, Input, 
Coupler, Output) cu geometria corespunzătoare din modelul 3D. 

5. Finalizare: 

o Faceți Finish. Testați mișcarea cu Joint Jog. 

 

Configurațiile complexe de manivelă (cu offset) sunt utile pentru modelarea fidelă a utilajelor reale. 
Asistentul Create Crank gestionează automat geometria și funcțiile matematice necesare pentru 
aceste bucle cinematice avansate. 
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4.2. LIMITE VARIABILE ALE ARTICULAȚIEI 
 

Obiectiv: Înțelegerea conceptului de limite variabile ale articulației, bazate pe poziția altei articulații, 
pentru a preveni auto-coliziunile, utilizând un exemplu demonstrativ. 

La roboții complecși, intervalul de mișcare permis pentru o articulație (de ex. J2) poate depinde de 
poziția unei articulații anterioare (de ex. J1), situație care poate conduce la coliziuni între verigile 
robotului. Limitele variabile rezolvă această problemă prin ajustarea dinamică a câmpurilor Lower 
Limit (limită inferioară) și Upper Limit (limită superioară) în funcție de valoarea altei articulații. 

Flux de lucru: Încărcarea și testarea (Jogging) demo-ului 

1. Încărcarea Studiului Demo: 

o Navigați la folderul \sysroot\Libraries\model_kinematics\var_limits. 

o Inserați componenta var_limit_robot_demo.cojt în studiu. 

o Faceți Zoom to Fit. 

 

2. Test 1 (fără limite variabile): 

o Executați clic dreapta (Clic dreapta) pe obiect și alegeți Joint Jog. 
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o Observație: Valorile Lower Limit și Upper Limit pentru J2 indică un interval fix 
(de ex. 30…90). 

o Mutați (jog) articulația J1 (de ex. la −30°). 

o Mutați J2. Brațul poate intra în coliziune cu baza (auto-coliziune), deoarece limitele 
J2 nu s-au adaptat la poziția lui J1. 

 

3. Test 2 (cu limite variabile): 

o (Obiectul demo este deja configurat cu limite variabile care funcționează). 

o Mutați J1 și J2 simultan. 

o Observație: Câmpurile Lower Limit și Upper Limit ale lui J2 se modifică dinamic 
pe măsură ce J1 se mișcă (de ex. când J1 = −30°, J2 poate varia între 0° și 120°; când 
J1 = +45°, J2 poate varia între −75° și 45°). 

 

Limitele variabile sunt implementate prin Joint Functions (funcții ale articulației) care definesc 
limitele unei articulații ca o funcție matematică de poziția unei articulații conducătoare. Această 
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abordare previne mișcările nepermise și optimizează plaja de lucru a robotului, fără intervenții 
manuale repetate. 

În practică, limitele variabile sunt folosite pentru a preveni auto-coliziunile sau pentru a modela 
restricții mecanice în care poziția unei verigi (link / verigă) limitează mișcarea verigilor următoare. 
În acest exemplu, limitele articulației J2 (Child Joint / articulație dependentă) sunt definite ca o 
funcție a poziției articulației J1 (Fixed Joint / articulație conducătoare). 

Flux de lucru: Încărcarea și Jogging-ul Demo 

1. Încărcarea Studiului Demo: 

o Navigați la folderul Studies al utilizatorului și încărcați studiul de bază (Load in 
Standard Mode). 

o Inserați componenta demo (Ex: var_limit_robot_demo.cojt) din folderul 
\sysroot\Libraries\model_kinematics\var_limits. 

o Alegeți Zoom to Fit. 

2. Testarea cu Joint Jog: 

o Executați Right-click pe obiectul robotului și alegeți Joint Jog. 

o Observație (J1 la -30): Mutați (jog) articulația J1 la poziția sa inferioară (Ex: -30 
grade). Observați că limitele articulației J2 se ajustează (Ex: Lower Limit la 0.00, 
Upper Limit la 120.00). 

o Observație (J1 la 45): Mutați (jog) articulația J1 la poziția sa superioară (Ex: 45 
grade). Observați că limitele J2 se ajustează diferit (Ex: Lower Limit la -75.00, Upper 
Limit la 45.00). 

 

3. Analiza Dependenței: 

o Mișcarea articulației J2 este restricționată de o funcție matematică aplicată pe J1 
(Articulația Fixă), reprezentând grafic un poligon de mișcare (Ex: Paralelogramul de 
mișcare J1-J2). 
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Limitele variabile sunt esențiale pentru a asigura că un robot simulat nu atinge niciodată o configurație 
ilegală sau nefezabilă mecanic, permițând mișcări complexe doar în limitele spațiului de lucru valid. 

 

4.2.1. Definirea limitelor variabile 

Obiectiv: Implementarea limitelor variabile pentru articulația J2 (articulație dependentă), pe baza 
poziției articulației J1 (articulație conducătoare), conform graficului de dependență definit. 

Implementarea limitelor variabile implică definirea unui set de puncte de date (coordonate) care 
formează un poligon în spațiul J1–J2. Acest poligon reprezintă regiunea de operare permisă. 

Flux de lucru: Pregătirea și accesarea proprietăților articulației 

1. Încărcarea Studiului: 

o Inserați obiectul robotului fără limite variabile (de ex. var_limit_robot_.cojt) și intrați 
în Modeling Scope. 

2. Editarea Articulației Dependente: 

o Alegeți Kinematics → Kinematics Editor. 

o Faceți clic dublu (Double-Clic) pe linia punctată care reprezintă articulația J2 
(articulația dependentă). 

o În dialogul Joint Properties (proprietățile articulației), faceți clic pe Expand dialog 
(extindere dialog). 

o Pentru Limits type (Tip Limite), selectați Variable (Variabile). 

o Pentru Fixed Joint (Articulație Fixă), selectați j1 (Articulația Conducătoare). 

o Rezultat: Se deschide dialogul Variable Joint Values - j2, dependant on j1 (valori 
variabile pentru articulație). 
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Flux de lucru: Crearea graficului de dependență (poligon) 

 

1. Introducerea Coordonatelor: 

o În dialogul Variable Joint Values, introduceți setul de 4 coordonate (puncte) care 
definesc poligonul de operare permis (paralelogramul). 

o Punct 1 (Colțul Stânga Jos): 

▪ Fixed j1 [deg]: -30.00. 

▪ Variable j2 [deg]: 0.00. 

o Punct 2 (Colțul Stânga Sus): 

▪ Fixed j1 [deg]: -30.00. 

▪ Variable j2 [deg]: 120.00. 

o Punct 3 (Colțul Dreapta Sus): 

▪ Fixed j1 [deg]: 45.00. 

▪ Variable j2 [deg]: 45.00. 

o Punct 4 (Colțul Dreapta Jos): 

▪ Fixed j1 [deg]: 45.00. 

▪ Variable j2 [deg]: -75.00. 
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o Observație: Graficul din dreapta se actualizează și afișează regiunea umbrită 
(albastru), care reprezintă spațiul de lucru permis. 

2. Salvarea Graficului: 

o Faceți clic pe OK în dialogul Variable Joint Values. 

o Faceți clic pe OK în dialogul Joint Properties. 

o Faceți clic pe Close în Kinematics Editor. 

Flux de lucru: Testarea și salvarea 

1. Testarea Cinematicii: 

o Executați Clic dreapta pe robot și alegeți Joint Jog. 

o Mutați J1 și observați cum limitele J2 se schimbă dinamic conform graficului definit. 
Încercați să mișcați J2 în afara zonei umbrite (acțiune nepermisă). 

2. Salvarea: 

o Resetați cinematica (Reset). 

o Alegeți Modeling → End Modeling pentru a salva modificările. 

Prin utilizarea seturilor de date Fixed Joint și Variable Joint, se poate implementa o limitare 
mecanică complexă. Această tehnică îmbunătățește acuratețea simulării, deoarece robotul se mișcă 
doar în spațiul său de lucru fizic fezabil. 

 

4.2.2. Implementarea Logicii Articulațiilor cu Funcții 

Obiectiv: Examinarea și înțelegerea modului în care funcțiile articulațiilor (Joint Functions) sunt 
utilizate pentru a adăuga logică complexă (de ex. mișcare secvențială, puncte de rupere) la articulațiile 
unui clește de sudură. 

Încleștarea (închiderea) unui clește de sudură poate avea o logică secvențială: o verigă se poate mișca 
până la un punct predefinit, iar abia apoi începe mișcarea celeilalte verigi. Această logică este 
implementată utilizând expresii condiționale și funcții matematice aplicate articulațiilor. 

Flux de lucru: Examinarea modelului demo (Gun Fun) 

1. Încărcarea Studiului: 

o Inserați componenta demo (Ex: gun_fun.cojt) în studiu. 

2. Testarea Mișcării Secvențiale: 

o Executați Clic dreapta pe pistolul de sudură și selectați Joint Jog. 

o Deplasați articulația conducătoare (de ex. J1 – articulația prismatică). 
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o Observație: Observați că doar o parte din brațele cleștelui se mișcă inițial. O altă parte 
începe să se miște doar după ce articulația conducătoare depășește o anumită valoare-
limită (de ex. 41.275). 

 

Flux de lucru: Analiza funcțiilor cinematice ale articulației (Kinematic Joint Functions) 

1. Accesarea Funcțiilor: 

o Deschideți Kinematics Editor pentru pistolul de sudură. 

o Selectați articulația dorită (de ex. J2). Faceți clic pe pictograma Joint Dependency 
(dependență între articulații). 

o Examinați funcția afișată (de ex. funcția pentru J2 sau J3). 

2. Analiza Logicii (Exemplu J2): 

o Funcția pentru J2 (brațul superior) este, de regulă, o expresie condițională (utilizând 
operatori de comparație, care returnează 1 pentru adevărat și 0 pentru fals). 

 

o Logică: 

▪ Dacă articulația J1 (articulația prismatică) este mai mică sau egală cu 41.275 
(condiția 1), valoarea lui J2 este o funcție liniară de J1. 

▪ Dacă articulația J1 este mai mare decât 41.275 (condiția 3), valoarea lui J2 
devine constantă (condiția 4). 

o Efect: Brațul superior se mișcă doar până la un anumit punct (la 41.275), după care 
mișcarea sa încetează, dar cleștele continuă să se închidă prin mișcarea celorlalte 
articulații. 
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3. Analiza Logicii (Exemplu J3): 

o Funcția pentru J3 (Ex: brațul inferior) poate arăta: 

 

o Logică: Mișcarea J3 este zero (0) până când J1 depășește pragul de 41.275. Odată 
depășit pragul, J3 începe să se miște în funcție de diferența (D(j1) - 41.275). 

o Efect: Brațul inferior nu se mișcă deloc până când celălalt braț/piston atinge un anumit 
punct. 

 

Funcțiile cinematice sunt cel mai avansat instrument de modelare a mișcării, permițând inginerilor să 
replice comportamente mecanice neliniare, complexe și secvențiale, esențiale pentru simularea 
precisă a ciclurilor de sudură sau de asamblare. 

 

4.2.3. Cinematică de urmărire a unei suprafețe 

Obiectiv: Examinarea unui exemplu de cinematică în care mișcarea unei articulații este definită de o 
funcție matematică complexă care simulează urmărirea unei suprafețe 3D. 

În aplicațiile de prelucrare sau vopsire, este necesar ca unealta să mențină o distanță constantă față de 
o suprafață curbată. Acest lucru se poate realiza prin definirea mișcării unei articulații (de ex. 
articulația de pe axa Z) ca o funcție a poziției altor articulații (de ex. X și Y). 

Flux de lucru: Inserarea și testarea modelului Surface Tracker 

1. Inserarea Componentei: 

o Inserați obiectul surfacetracker.cojt (CAM Motion Example) din folderul 
\sysroot\Libraries\model_kinematics\more_kin în studiul curent. 

2. Izolarea și Jogging: 

o Executați Clic dreapta pe obiectul CAM Motion Example și alegeți Display Only. 

 

o Executați Clic dreapta pe obiect și selectați Joint Jog. 
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o Deplasați articulațiile X și Y ale dispozitivului (sistem prismatic). Articulația Z se va 
ajusta automat. 

3. Observație: Pe măsură ce X și Y se schimbă, valoarea Z se modifică conform funcției, 
simulând urmărirea unei suprafețe. 

Flux de lucru: Analiza Funcției Cinematice Z 

1. Accesarea Funcțiilor: 

o Alegeți Modeling → Set Modeling Scope. 

o Alegeți Kinematics → Kinematics Editor. 

o Selectați articulația Z (care este dependentă). 

 

o Faceți clic pe pictograma Joint Kinematics Functions. 

 

2. Examinarea Expresiei: 

o Funcția articulației Z este afișată ca o expresie matematică complexă, utilizând 
operatorii pow (putere) și valorile articulațiilor D(X) și D(Y): 
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o Logică: Poziția articulației Z este calculată ca o funcție de paraboloid a articulațiilor 
X și Y. 

o Efect: Acest lucru forțează vârful dispozitivului să se deplaseze pe o suprafață curbă 
definită de funcția respectivă, demonstrând cum se realizează mișcarea ghidată pe 
suprafață. 

3. Închiderea: 

o Închideți dialogul Kinematics Editor. Alegeți Modeling → Reload Component 
pentru a ieși din modul de modelare fără a salva. 

Funcțiile cinematice permit Process Simulate să modeleze mișcări neliniare și complexe de surface 
tracking (urmărirea suprafeței), critice pentru aplicații CAM, vopsire sau debavurare. 

 

4.3. EXEMPLE 
 

4.3.1. Articulația de tren 

Obiectiv: Examinarea structurii cinematice a unui mecanism de tren (Train Joint), care ilustrează o 
altă aplicație a funcțiilor cinematice pentru mișcări complexe. 

Mecanismele de tren (de ex. roți și biele) sunt sisteme cu buclă cinematică închisă, iar mișcarea lor 
este definită de funcții sinusoidale sau polinomiale. Deși Process Simulate nu are un asistent dedicat, 
aceste mișcări pot fi emulate prin Joint Functions (funcțiile articulației). 

Flux de lucru: Inserarea și testarea modelului Train Joint 

1. Inserarea Componentei: 

o Inserați obiectul trainj.cojt din folderul 
\sysroot\Libraries\modeling_kinematics\functions în studiu. 

2. Jogging: 

o Executați Clic dreapta pe obiectul trainj și selectați Joint Jog. 

o Deplasați articulațiile (de ex. cpin și barpin) pentru a observa mișcarea sincronizată 
a roții și a bielei. 
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3. Analiza Funcției: 

o Alegeți Kinematics → Kinematics Editor. 

o Examinați funcțiile definite pentru articulațiile dependente (de ex. cpin și barpin). 

o Observație: Funcțiile sunt, de regulă, ecuații trigonometrice (sinus, cosinus) care 
corelează rotația roții cu mișcarea bielei. 

Exemplul Train Joint demonstrează versatilitatea funcțiilor cinematice, arătând cum o mișcare 
geometrică complexă poate fi descrisă printr-un set de ecuații. 

 

4.3.2. Îmbinare cu camă 

Obiectiv: Examinarea unui mecanism de camă (Cam Joint), care folosește o funcție pentru a simula 
mișcarea de urmărire a unui contur excentric. 

Mecanismele cu camă sunt utilizate pentru a transforma mișcarea de rotație în mișcare liniară sau 
oscilatorie, adesea bazată pe un contur non-circular. 

Flux de lucru: Inserarea și testarea modelului Cam Joint 

1. Inserarea Componentei: 

o Inserați obiectul camfinal.cojt din folderul 
\sysroot\Libraries\modeling_kinematics\functions în studiu. 

 

2. Jogging: 

o Executați Clic dreapta pe obiectul camfinal și selectați Joint Jog. 
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o Deplasați articulația (cea rotoare) pentru a observa cum tija (follower / urmăritor) 
urmărește conturul camei, generând o mișcare neuniformă. 

3. Analiza Funcției: 

o Alegeți Kinematics → Kinematics Editor. 

o Examinați funcția definită pentru articulația prismatică (tija urmăritorului). 

o Observație: Funcția poate descrie conturul camei, corelând mișcarea liniară a tijei 
(urmăritorului) cu mișcarea de rotație a camei. 

 

 

Exemplul Cam Joint ilustrează utilizarea funcțiilor cinematice pentru a modela mișcări neliniare, 
specifice utilajelor care folosesc mecanisme de indexare sau de acționare intermitentă. 

 

4.4. ECHIPAMENTE COMPUSE 
 

4.4.1.  Setarea echipamentului compus 

Obiectiv: Crearea unui echipament compus care integrează o șină (rail) și un robot (Robot and Rail) 
și definirea atașamentului cinematic. 

Compound Equipment (echipament compus) reprezintă o ierarhie de resurse (de ex. șină + robot + 
unelte) tratată ca o singură entitate. Aceasta este necesară pentru definirea roboților cu axe externe 
(șine sau poziționatoare). Robotul montat pe șină trebuie configurat astfel încât axa șinei să fie definită 
ca External Axis (axă externă). 

Flux de lucru: Crearea prototipului de echipament Rail (șină) 

1. Check Out (rezervare) bibliotecă: 

o Navigați la Libraries și executați Check Out pentru biblioteca 
compound_equipment. 

2. Crearea Prototipului: 

o Executați clic dreapta (Clic dreapta) pe biblioteca compound_equipment și alegeți 
New (nou). 
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o Selectați tipul Equipment Prototype (prototip de echipament). Denumiți-l 
Rail_user1. 

3. Atașarea Componentelor: 

o Trageți și plasați prototipurile de resursă (de ex. e_carriage_1 [cărucior] și e_rail_125 
[șină]) din biblioteca compound_equipment2 pe noul prototip Rail_user1. 

4. Check In (predare): 

o Executați Check In pentru biblioteca compound_equipment. 

Flux de lucru: Crearea prototipului de echipament Robot și șină 

1. Crearea Prototipului: 

o Executați Clic dreapta pe biblioteca compound_equipment și alegeți New. 

o Denumiți-l Robot and Rail_user1. 

2. Atașarea Echipamentului Compus și a Robotului: 

o Trageți și plasați prototipul Rail_user1 (echipamentul compus) pe Robot and 
Rail_user1. 

o Trageți și plasați prototipul real_robot (robotul) pe Robot and Rail_user1. 

 

3. Poziționarea Robotului pe Șină: 

o Inserați instanța Robot and Rail_user1 în Graphic Viewer (prin drag-and-drop / 
glisare și plasare). 
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o Modeling Scope: Alegeți Modeling → Set Modeling Scope pentru Robot and 
Rail_user1. 

o Executați Clic dreapta pe robotul real_robot și alegeți Relocate. 

o Selectați cadrul de montare (de ex. un cadru magenta) de pe căruciorul șinei (veriga 
e_carriage_1) ca To frame (cadru destinație). 

o Faceți clic pe Apply și Close. 

o Rezultat: Robotul este poziționat corect pe cărucior. 

Flux de lucru: Definirea atașamentului cinematic și a axelor externe 

1. Definirea Bazei Cinematice: 

o Kinematics Editor: Deschideți Kinematics Editor pentru Robot and Rail_user1. 

o Bază: creați două verigi simple și o articulație între ele (bucla de bază necesară pentru 
a permite atașamentul cinematic). 

 

2. Atașarea Robotului la Cărucior: 

o Selectați robotul real_robot. 

o Alegeți Modeling → Attach (Atașează). 

o Selectați geometria căruciorului (e_carriage_1) ca verigă de atașament. Faceți OK. 

3. Definirea ca Axă Externă: 

o Executați Clic dreapta pe robotul real_robot și alegeți Robot Properties (Proprietăți 
Robot). 

o Navigați la fila External Axes (Axe Externe). 
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o Faceți clic pe Add (adaugă). Selectați dispozitivul șinei (de ex. e_carriage_1). 
Articulația J1 a șinei ar trebui să fie selectată automat. Faceți OK. 

 

4. Salvarea Finală: 

o Alegeți Modeling → End Modeling. 

o Salvați prototipul Robot and Rail_user1 în biblioteca compound_equipment. 

o Faceți File → eMServer Selective Update (selectând Resources și Operations). 

 

Definirea unui Compound Equipment este obligatorie pentru sistemele robotice avansate. Prin 
atașarea cinematică a robotului la axa J1 a căruciorului, mișcarea șinei devine o axă externă 
controlabilă, extinzând spațiul de lucru al robotului pentru programarea traiectoriilor lungi. 
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5. ROBOTICĂ GENERALĂ ȘI MANAGEMENTUL STUDIULUI 

 

 

Acest capitol servește ca o introducere practică în mediul de lucru zilnic din Process Simulate, 
concentrându-se pe încărcarea și examinarea studiilor complexe de robotică (la nivelul Study level 
(nivel de studiu)), cel mai frecvent utilizat în producție. De asemenea, sunt revizuiți pașii 
fundamentali pentru crearea unui studiu nou. 

 

5.1. PREZENTARE GENERALĂ A DATELOR DE LUCRU 
 

Familiarizarea cu diverse tipuri de studii de robotică (sudură în puncte, asamblare, pick-and-place) 
ajută la înțelegerea structurilor de date specifice fiecărui proces. Această activitate se concentrează 
pe încărcarea și inspecția vizuală a studiilor preconfigurate. 

Flux de lucru: inițierea sesiunii și setarea Working Folder (folder de lucru) 

1. Lansarea și Logarea: 

o Porniți Process Simulate (dacă nu este deja deschis). 

o Pentru Login (autentificare), introduceți eMS database user ID (ID utilizator în baza 
de date eMS) (ex.: user1). Faceți clic pe OK. 

 

 

2. Definirea Working Folder (folder de lucru): 

o În Navigation Tree (arbore de navigare), navigați la colecția Working Folders. 
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o Executați Clic dreapta (clic dreapta) pe folderul alocat utilizatorului și selectați 
Check Out. Confirmați cu OK. 

o Alegeți File → Project Management → Set as Working Folder. 

Flux de lucru: încărcarea și examinarea studiilor specifice 

1. Navigarea la Studii: 

o În Navigation Tree (arbore de navigare), extindeți folderul Studies → folderul de 
studiu alocat (ex.: Line... StudyFolder). 

o Executați Check Out with Hierarchy (check-out cu ierarhie) pentru folderul de 
studiu alocat. 

2. Studiul 1: sudură în puncte (Spot Welding) și manipulare: 

o Navigați la sub-folderul mount_wp. 

o Executați Clic dreapta pe studiul station22 și alegeți Load in Standard Mode. 

 

o Examinare: Observați în Graphic Viewer (vizualizator grafic) și Object Tree 
(arbore de obiecte) structura celulei (roboți montați, piese de asamblat). 

o Studiul 2: procesare (Processing): 
o Navigați la subfolderul Processing. 

o Executați Clic dreapta pe studiul station02 și alegeți Load in Standard Mode. 

 

o Examinare: Inspecția vizuală a celulei cu echipamentul încărcat. 
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3. Studiul 3: pick-and-place (PnP): 

o Navigați la sub-folderul Other selected studyfolder. 

o Executați Clic dreapta pe studiul pnp și alegeți Load in Standard Mode. 

o Examinare: Concentrați-vă pe cleștii de prindere (grippers) și pe modul în care 
piesele sunt manipulate. 

4. Studiul 4: sudură în arc multi-axis: 

o Rămâneți în sub-folderul Other selected studyfolder. 

o Executați Clic dreapta pe studiul arc multi axis și alegeți Load in Standard Mode. 

o Examinare: Observați pistoalele de sudură în arc și necesitatea coordonării între 
roboți sau axe. 

Revizuirea datelor de lucru oferă o perspectivă asupra diversității aplicațiilor de robotică modelate în 
Process Simulate. Studiile la nivelul Study level (nivel de studiu) reprezintă, de regulă, punctul 
principal de intrare pentru inginerul de simulare. 

 

5.2. CREAREA UNUI STUDIU 
 

Crearea unui studiu nou este o procedură fundamentală. Deși a fost prezentată în Capitolul 1, reluarea 
procesului asigură însușirea pașilor necesari pentru a crea un mediu de lucru curat, destinat unei noi 
secvențe de simulare. 

Flux de lucru: pregătirea proiectului și a folderului de studiu 

1. Închiderea Proiectului: 

o Alegeți File → Close Project. Când sunteți întrebat, selectați No pentru actualizarea 
eMServer. 

2. Deschiderea Proiectului de Bază: 

o Alegeți File → Open Project. 

o Selectați proiectul de bază (ex.: Basics Project -- user...). 

o Faceți clic pe OK. 

3. Check-out pentru folderul de studiu: 

o În Navigation Tree (arbore de navigare), extindeți folderul Studies. 

o Localizați folderul de studiu alocat (ex.: Line 1 StudyFolder). 
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o Executați Clic dreapta pe folder și alegeți Check Out. 

o Atenție: Bifați with Hierarchy (cu ierarhie) și confirmați cu OK. 

o Extindeți folderul. 

Flux de lucru: crearea studiului și asocierea structurii 

1. Crearea Studiului Nou: 

o Executați Clic dreapta pe folderul de studiu alocat (Ex: Line 1 StudyFolder) și alegeți 
New. 

o În dialogul New, bifați Robcad Study. 

o Redenumiți studiul la Study2. 

o Faceți clic pe OK. 

2. Asocierea Operation Tree (arbore de operații): 

o Localizați Operation Tree CompoundOperation în Navigation Tree (arbore de 
navigare). 

o Executați Drag and drop (trageți și plasați) Operation Tree CompoundOperation 
pe noul studiu Study2 RobcadStudy. 

o Extindere: Extindeți arborele sub studiul Study2 pentru a vedea operațiile asociate. 

Flux de lucru: încărcarea și vizualizarea 

1. Încărcarea Studiului: 

o Executați Clic dreapta pe studiul Study2 RobcadStudy și alegeți Load in Standard 
Mode. 

2. Vizualizarea: 

o În Graphic Viewer (vizualizator grafic), executați Clic dreapta (clic dreapta) și 
selectați Display All (afișare completă). 

o Executați Clic dreapta (clic dreapta) și selectați Zoom to Fit (încadrare în fereastră). 

Recrearea unui studiu de bază consolidează înțelegerea procesului PPR (Product-Process-Resource). 
Studiul Study2 reprezintă acum un mediu de lucru funcțional, populat cu structurile de operații și 
resursele necesare pentru simulări detaliate. 
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6. SUDURA ÎN PUNCTE  

 

 

Sudura în puncte este un proces de fabricație de bază în Process Simulate, în special în industria auto. 
Acest capitol detaliază fluxul de lucru pentru vizualizarea caracteristicilor de sudură, proiecția 
acestora pe piese (asigurând orientarea corectă a pistolului) și editarea ulterioară a traiectoriei de 
sudură. 

 

6.1. CARACTERISTICI DE SUDURĂ ÎN PUNCTE  
 

6.1.1. Vizualizarea caracteristicilor de sudură 

Obiectiv: Încărcarea unui studiu de sudură și examinarea detaliată a caracteristicilor de fabricație 
(weld locations – locații de sudură) utilizând Mfg Viewer. 

Caracteristicile de fabricație (Manufacturing Features – caracteristici de fabricație), cum ar fi 
WeldPoint (punct de sudură), reprezintă informații de inginerie preluate din surse externe (de ex. 
Teamcenter). Acestea definesc locația, materialul și grosimea, dar nu și orientarea robotului. 

Flux de lucru: încărcarea studiului și deschiderea Mfg Viewer 

1. Încărcarea Studiului: 

o Asigurați-vă că Process Simulate este pornit și că proiectul corect (de ex. Robotics 
Sim Begin) este deschis. 

o Navigați la colecția Studies → folderul de studiu alocat (de ex. Line... StudyFolder) 
→ subfolderul processing. 

o Faceți clic dreapta pe studiul station02 și alegeți Load in Standard Mode. 

2. Deschiderea Mfg Viewer: 

o Selectați o piesă în Graphic Viewer și alegeți View → Zoom to Selection. 

o Alegeți View → Viewers → Mfg Viewer. 
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3. Filtrarea caracteristicilor: 

o În Mfg Viewer, faceți clic pe săgeata derulantă de lângă pictograma Filter și asigurați-
vă că WeldPoint este selectat. 

o Rezultat: Mfg Viewer afișează o listă de caracteristici de sudură (de ex. e266, e263) 
asociate pieselor din scenă. 

Flux de lucru: personalizarea coloanelor (Attributes – atribute) 

1. Accesarea personalizării: 

o În Mfg Viewer, faceți clic pe pictograma Customize (personalizare). 

 

2. Selectarea atributelor: 

o În dialogul Mfg Viewer - Properties Customization, extindeți MFG Viewer Fields. 

o Selectați atributele dorite (de ex. Projection Indication și Assignment Indication) și 
mutați-le în lista Show properties in following order utilizând butonul săgeată. 
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o Extindeți WeldPoint și adăugați atribute specifice (de ex. informații despre grosimea 
materialului). 

o Faceți clic pe OK. 

o Observație: Coloanele din Mfg Viewer se actualizează și includ informațiile 
selectate. 

Flux de lucru: setarea salvării automate (Auto Save – salvare automată) 

1. Accesarea opțiunilor: 

o Alegeți Tools → Options. 

 

o În fila General, bifați caseta Every (fiecare) din zona Update Prompt (solicitare de 
actualizare). 

o Setați intervalul (de ex. 30 de minute). 

o Faceți clic pe OK. 

o Efect: Process Simulate va solicita periodic salvarea, reducând riscul pierderii datelor 
locale. 
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Mfg Viewer este instrumentul principal pentru gestionarea datelor de fabricație, permițând 
inginerului să verifice atributele punctelor de sudură înainte de proiecție și de utilizarea acestora în 
operațiile robotizate. 

 

6.1.2. Proiectarea caracteristicilor de sudură 

Obiectiv: Proiectarea locațiilor de sudură pe suprafața piesei și setarea orientării inițiale, pentru 
pregătirea traiectoriei robotului. 

Locațiile de sudură din Mfg Viewer sunt inițial puncte în spațiu. Acestea trebuie proiectate pe 
geometria piesei, iar orientarea trebuie ajustată astfel încât să fie perpendiculară pe suprafață – o 
constrângere critică pentru sudura în puncte. 

Flux de lucru: proiecția punctelor de sudură 

1. Pregătirea Operației: 

o În Operation Tree (arbore de operații), asigurați-vă că operația de simulare (de ex. 
WeldOperation 1) este afișată (pictograma cu pătrat plin). 

o Observație: O linie punctată în Graphic Viewer indică ordinea punctelor din operația 
de simulare. 

2. Lansarea Proiecției: 

o Selectați operația de simulare (de ex. WeldOperation 1). 

o Alegeți Weld → Spot → Project Weld Points (Sudură → Punct → Proiectează 
puncte de sudură). 

3. Configurarea Proiecției: 

o Bifați Project on approximation only (proiectează doar pe aproximare). 

▪ Notă: Această opțiune se utilizează atunci când geometria exactă a piesei nu 
este disponibilă (de ex. fișierul JT conține doar aproximări), forțând proiecția 
să folosească datele aproximative. 

o Secțiunea Projection Options permite alinierea proiecției cu suprafața exterioară 
(Align projection with outer surface) și forțarea proiecției peste găuri (Force 
projection over holes). 

4. Executarea Proiecției: 

o Faceți clic pe Project (Proiectează). 

o Rezultat: Fiecare locație de sudură primește o bifă albastră în dialog, indicând 
succesul proiecției. Locațiile sunt fixate pe suprafața piesei, iar orientarea (axa Z) 
devine perpendiculară pe suprafața locală. 
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5. Închiderea: 

o Faceți clic pe Close. 

Proiecția punctelor de sudură este un pas esențial de conversie, transformând datele de inginerie în 
locații 3D utilizabile în programarea robotului. 

 

6.2. EDITAREA UNEI TRAIECTORII DE SUDURĂ 
 

După proiecție, punctele de sudură formează o traiectorie. Această traiectorie necesită adesea ajustări: 
reordonarea punctelor, reorientarea abordării pistolului și simularea pentru a verifica fezabilitatea 
mișcărilor. 

 

6.2.1. Ajustarea unei Traiectorii de Sudură 

Obiectiv: Etichetarea vizuală a locațiilor, reordonarea secvenței, alocarea pistolului și orientarea 
vectorilor de abordare. 
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Flux de lucru: Etichetarea Vizuală și Reordonarea 

1. Etichetarea Locațiilor: 

o În Operation Tree, selectați prima locație din operația WeldOperation 1. 

o Țineți apăsată tasta [Shift] și selectați ultima locație. 

 

o Alegeți Tools → Notes → Object Notes. 

o Rezultat: Note textuale cu numele locației (Ex: e254, e263) sunt atașate fiecărui punct 
de sudură în Graphic Viewer. Aranjați-le prin tragere pentru a nu se suprapune. 

 

2. Reordonarea Secvenței (Drag and Drop): 

o Executați Clic dreapta pe operația WeldOperation 1 și alegeți Set Current 
Operation. 

o În Sequence Editor, trageți și plasați locațiile (de ex. e254, e257, e260) în ordinea 
dorită (de ex. de la dreapta la stânga). 
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Flux de lucru: Alocarea Pistolului (Gun) și Orientarea Manuală 

1. Alocarea Pistolului: 

o Executați Clic dreapta pe operația WeldOperation 1 și alegeți Operation Properties 
(Proprietăți Operație). 

o Navigați la fila Process (Proces). 

o În caseta Gun (Pistol), selectați pistolul de sudură (Ex: gun1) din Graphic Viewer 
(nu selectați robotul). 

o Faceți OK. 

2. Orientarea Vectorului (Location Manipulator): 

o Selectați prima locație (Ex: e254). 

o Alegeți Operation → Path Editing → Location Manipulator. 

o Observație: Un pistol temporar este plasat la locația e254. 
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o Bifați Rotate to maximum allowed limitation (Rotește la limitarea maximă 
permisă). 

o Rotiți locația în jurul axei Z (utilizând manipulatorul sau câmpurile de rotație) pentru 
a găsi un vector de abordare care evită coliziunile. 

o Notă: Această comandă rotește orientarea locației, iar pistolul o urmează, menținând 
perpendicularitatea pe suprafață. 

Flux de lucru: Alinierea Orientării și Simularea 

1. Alinierea Orientărilor: 

o Selectați operația WeldOperation 1. 

o Alegeți Weld → Align Locations (Aliniază Locațiile). 

o În dialog, selectați locația pilot (Ex: e254) în caseta Align selected Locations to. 

o Rezultat: Orientarea tuturor celorlalte locații din path este aliniată cu orientarea 
locației e254 (cu menținerea constrângerii de perpendicularitate pe suprafața locală). 
Faceți OK. 

 

2. Simularea Path-ului: 

o În Sequence Editor, faceți clic pe Play Simulation Forward. 

o Observație: Vizionați simularea pistolului de-a lungul traiectoriei. Verificați dacă 
orientarea este fezabilă și dacă nu există modificări bruște de orientare (Ex: flips). 

3. Finalizarea: 

o Faceți clic pe Jump Simulation to Start. 
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o Alegeți File → eMServer Selective Update (selectând Resources și Operations) 
pentru a salva modificările în baza de date. 

 

Editarea path-ului de sudură este un proces iterativ. Prin reordonare, alocare de unelte și aliniere a 
orientărilor, se obține o traiectorie optimizată, care reduce uzura robotului și asigură calitatea sudurii. 

 

6.3. VALIDAREA PISTOLULUI DE SUDURĂ PRIN SECȚIUNI MULTIPLE  
 

Validarea pistolului (Gun Shank Validation – validarea gâtului pistolului) este un pas critic în 
planificarea sudurii și are ca obiectiv verificarea vizuală a clearance-ului (spațiului liber) dintre 
pistolul de sudură și piesă, în special în zonele aglomerate. Acest lucru se realizează prin crearea unor 
secțiuni de tăiere (cross-sections – secțiuni transversale) la locațiile-cheie de sudură, utilizând 
instrumentul Multi Sections (secțiuni multiple). 
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Flux de lucru: pregătirea și lansarea Multi Sections 

1. Selectarea Operației: 

o Asigurați-vă că studiul station02 este încărcat. 

o Selectați operația de simulare de sudură (de ex. WeldOperation 1). 

2. Lansarea MultiSections: 

o Alegeți Weld → Multi Sections (Sudură → Secțiuni Multiple). 

o Observație: Se deschide dialogul MultiSections, care listează toate locațiile de 
sudură (Locations – locații) din operație. Coliziunile existente pot fi indicate (de ex. 
printr-un X lângă o locație). 

 

3. Extinderea și vizualizarea: 

o În MultiSections, faceți clic pe Expand Dialog (extinde dialogul). 

 

o Bifați Show Cutting Box of selected Section (afișează cutia de tăiere a secțiunii 
selectate) și Show Gun (afișează pistolul). 

o Observație: În Graphic Viewer se afișează o cutie de tăiere transparentă și o 
reprezentare a pistolului la locația selectată (de ex. e254). 
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Flux de lucru: definirea și poziționarea cutiei de tăiere (Cutting Box – cutie de tăiere) 

1. Poziționarea Pistolului: 

o Faceți dublu clic pe o locație de sudură din listă (de ex. e263). Pistolul sare la acea 
locație. 

2. Ajustarea Dimensiunilor Cutiei: 

o Faceți clic pe Fit all Cutting Boxes to Gun (potrivește toate cutiile de tăiere la pistol) 
pentru a obține un volum inițial. 

 

o Secționare 2D: Modificați dimensiunile cutiei pentru a crea o secțiune 2D subțire, 
perpendiculară pe pistolul de sudură: 

▪ În dialogul Cutting Box Dimensions, pentru Y Dimension (dimensiunea Y), 
introduceți valori mici (de ex. Low: -1, High: 1). 

▪ Ajustați celelalte dimensiuni (X și Z) pentru a acoperi volumul gâtului 
pistolului (de ex. mărind valorile cu 20 mm). 

 

o Rezultat: Cutia de tăiere se transformă într-un plan subțire, iar secțiunea tăiată este 
afișată în vizualizatorul dedicat MultiSections. 

Flux de lucru: inspectarea secțiunilor și salvarea 

1. Afișarea vederii laterale: 

o În dialogul MultiSections, faceți clic pe Show section side view (afișează vederea 
laterală a secțiunii). 

o Rezultat: Secțiunile tăiate sunt aliniate într-o vedere laterală, permițând inspecția 
vizuală a spațiului liber. 
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2. Identificarea problemelor: 

o Parcurgeți lista Locations (locații) din MultiSections. La dublu clic, pistolul sare la 
locația selectată. 

 

o Inspecție: Verificați în Graphic Viewer și în vederea laterală dacă gâtul pistolului 
atinge piesa (coliziune) sau dacă există clearance (spațiu liber) insuficient. 

3. Salvarea ca obiect: 

o În dialogul MultiSections, faceți clic pe Store Sections (stochează secțiunile). Alegeți 
All Sections as one Component (toate secțiunile ca o singură componentă). 

o Faceți clic pe Save as (salvează ca) și salvați componenta (de ex. 
MultiSection_Validation.cojt) în folderul \\sysroot\\sections\\user.... 

o Rezultat: Secțiunile tăiate sunt salvate ca o singură entitate geometrică și pot fi 
transmise altor departamente (de ex. proiectantului pistolului) pentru revizuire. 

Instrumentul Multi Sections oferă o metodă directă de analiză geometrică pentru verificarea 
clearance-ului (spațiului liber) gâtului pistolului la fiecare punct de sudură și pentru identificarea 
coliziunilor potențiale înainte de execuția robotică. 
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